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1. Introduction

Welcome to ShutterBug Version 1.1

How to Use this Manual

This manual is  designed to take you through each window of ShutterBug, step by step, 
starting with initial user settings and getting started, to building content, exporting, and 
designing your own look. There are 9 chapters divided into two fundamental sections - 
content and layout.  Wherever possible, labeled diagrams accompany the written instruc-
tions for added help and explanation.

Chapters 1-5  

Addresses the primary functionality and features of ShutterBug, helping you get started 
building content and exporting your  web site. 

Chapters 6-9

Contains the foundation for the layout and design of your website  and how to use some of 
the advanced featers.  

  

What is ShutterBug?

ShutterBug is a barrier-breaker. Don't let the price or small download size fool you. It can 
do everything that pro-web authoring tools can do, without making you do all the work. 
ShutterBug is built for creativity and speed, aimed at removing the obstacles of publishing 
content to the web.  

ShutterBug is  an easy-to-use, content building application for creating photo albums, 
photo journals, or any other type of web page, and publishing to the web. From beginners 
to professional illustrators, to educators and photographers, and even pro web designers, 
ShutterBug's tools offer a new solution for anyone who needs to create a website easily, 
quickly, and done up in style. The streamlined tabbed interface and feature rich palettes let 
you concentrate on your project, supporting a smooth, and productive work flow.  
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ShutterBug is not a photo library or storage tool like iPhoto, nor  is it a scaled down web 
album generator. Rather, ShutterBug focuses on helping you build your  content, adding or 
creating a personalized theme for the look  and feel, and exporting to a .Mac account, other 
web server, or a folder on your computer. ShutterBug provides the flexibility to let you 
create as  little or as much as you want, without constraining you to a canned template or  a 
limited number of user options.  

You can drag and drop digital photos from iPhoto or  another folder, edit the photos using 
the built-in ImageWell editor, design the look  and feel or use a pre-made customizable 
template, and preview your site via the built-in browser. ShutterBug web sites will render 
properly in all modern browsers on multiple platforms, eliminating the need to test your 
site in multiple external browsers. 

The Layout tools will allow you to unleash your creativity with very little learning curve 
involved, or perhaps none at all. You can create navigation roll-overs, edit the various  page 
elements, add external links, change colors, font styles, add images and tiled backgrounds 
to your pages, create collages with floating pictures, freestyle slideshows, embed links in 
thumbnails, and much, much more. No HTML knowledge is  needed to build a ShutterBug 
website nor  any CSS knowledge to give your web pages a stylish look. 

Sounds to good to be true?  Give ShutterBug a whirl and find out for yourself!

Technical Specifications

System Requirements

•  Mac OS X 10.3.6 or better (tested and works on Tiger 10.4).

•  Internet connection and web host space for uploading web sites  to.

Image File Format Support

ShutterBug can import jpg, gif, tif, png, and bmp file formats. 

Requirements for Viewing  Web  Pages Created with ShutterBug

ShutterBug websites can be viewed properly by all modern browsers and computers.  If a 
visitor to your site reports problems viewing your web pages, please check  the following 
requirements and ensure they are using the latest version of their browser.  Javascript 
must be enabled in the browser to view slideshows properly.
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ShutterBug  output has been tested for compliance on the following  platforms:

Mac OS X

• IE 5.0 or  better

• Safari

• Mozilla 1.0 or better

• Firefox  1.0 or better

• Opera 6.0 or better

Mac OS 9

• IE 5.0 or  better

• Netscape 6.0 or better

Windows

•  IE 6.0 or  better

•  Firefox  1.0 or better

Web pages are best viewed when the browser is displaying text size at Normal or  100%.  
Increasing or decreasing the text size via the browser controls will result in a look that is 
inconsistent with the preview inside of ShutterBug. 

HTML & CSS Output

ShutterBug outputs HTML 4.01 Transitional and has been tested and validated by W3C 
Markup Validator. The CSS output is CSS Level 1 & Level 2, and has been tested and 
validated by W3C CSS Validator. You can visit these links and enter the URL of your site 
to check it for valid HTML and CSS. ShutterBug file encoding is UTF-8. 

PLEASE NOTE:  

We do not recommend that you hand edit the final HTML output of ShutterBug.  The 
HTML output has  been carefully computed to render correctly on all platforms.  Addi-
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tionally, we do not recommend post-processing of the HTML output with 'optimizers' as 
this could result in incompatibilities.  We do not support problems that result from hand 
editing or  post-processing of ShutterBug output. 

We strive for  rendering excellence.  If ShutterBug outputs HTML that is not being ren-
dered correctly, please let us know at the ShutterBug support forum or by sending an 
email to support@xtralean.com.

Installing & Uninstalling ShutterBug

How to Install ShutterBug

Drag the ShutterBug icon into your Applications  folder.  Double-click the icon to launch 
ShutterBug.  After you have installed ShutterBug, you can discard the .dmg disk image 
and eject the install disk.  

How to Uninstall ShutterBug

To uninstall ShutterBug, simply drag the application to your Trash and remove the fol-
lowing items from your hard drive:

• In your Home folder, remove the following file: 

  Library/Preferences/com.xtralean.paradise.plist

• Also in your Home folder, remove the following folder: 

  Library/Application Support/XtraLean

After  removing the above file and folder, all traces of ShutterBug will be removed from 
your system.

Understanding the Blueprint

ShutterBug's capabilities  and interface are designed around the idea of building blocks and 
the separation of content and layout. This separation allows for  content and/or the design 
of the site to be quickly edited and updated independent of each other. This means the 
content can be changed without touching the design, and vise versa. The incremental Send 
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feature then allows for quick export of the changes only, ensuring a quick update process 
from start to finish.  

You can think of ShutterBug's application design as a framed photograph hanging on your 
wall. The photo is the content or base that you have created (Content HTML). Now you 
want to make it more presentable to others. So you add a frame and perhaps a matte (Lay-
out CSS). Now you need a place to display it. So you hang it on your wall (Preview & 
Upload to the Web).  

The Content Window = HTML = foundation and body of the website = Content

The Layout Window = CSS = framework that encompasses the body = Design

The Preview Window = HTML + CSS = finished product all glued together = Website

Changing the content will not affect the design of your site, nor will changing the design 
affect the content. These two building blocks are separated so that you can easily update 
your content in the future without having to worry about inadvertently moving a masthead 
or  menu, or any other object on the page, out of place from it's original position. This  ap-
proach replaces the need for using framesets or  composing tables, the approach used by 
the traditional, more expensive web authoring tools. ShutterBug masks these complexities 
and allows you to reduce the amount of time spent in a learning curve or  dealing with 
frustrating positioning and rendering.  

Three Main Windows & Capabilities

ShutterBug's user interface is organized around three main tabs that reveal the work area 
windows for each one: Content, Preview, & Layout.  Some people prefer to create their 
content first, while others prefer to create the layout and design of the site first.  Regard-
less of which order you work  in, ShutterBug separates the content and design into two 
building blocks that come together in the Preview window.  

If you are still getting acquainted with ShutterBug, we do suggest building the content first 
in the Content window. This will make it easier to design the layout or customize a tem-
plate later on in the Layout window, as you will have the visuals  of where the content re-
sides on the page.  
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The pictures below include a brief description of the features available in each window. 
Click the thumbnail below to get a quick snapshot of each tab, its corresponding interface 
and available features:

Content View

The Content window facilitates the starting point of your website: building the content for 
your photo albums, groups, text descriptions, navigation menu, and the overall organiza-
tion of your web pages.  The content window also contains  the ImageWell image editor 
and an advanced editing mode for adding META tags and additional HTML. 
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Preview

The Preview window contains a built in web browser (XtraLean's own proprietary 
browser) for web previewing your site and testing links. The interface allows you to navi-
gate through your site using 3 different methods: by clicking on your navigation menu and 
text links, using the navigator buttons at the top of the interface (home, forward, back), or 
by selecting pages from the drop down list at the top of the interface. The preview window 
also lets you control+click  to go back to the ImageWell editor in case you need to do some 
last minute edits on your pictures, as well as  the one-click Send button for exporting your 
site.  The Preview window is also the place to select and apply a theme, and choose differ-
ent templates for quick  customization of your pages.
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Layout View

The Layout window facilitates the creation and editing of the design of your site. The 
WYSIWYG design tools let you do as little as minor tweaks or as much as a complete 
overhaul or creation of your very own. This  is the place to edit the content for colors, 
styles, positioning, borders, size, collages, drop shadows, slideshows, thumbnail display, 
and many other properties of the elements and content contained in your site. The inter-
face contains tabs that hold the design tools for each element in your website. Customizing 
and managing templates and individual pages can also be done from within the Layout 
window. The window is collapsable in order to give you more room on the canvas, and 
includes object guidelines and handy ruler guides to help you easily align objects on the 
page.
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Chapter 2 

Getting Started

Stay organized from the beginning and life will be much simpler. This section outlines 
where to start when opening ShutterBug for  the first time and creating your first Shutter-
Bug project.  Some general settings and organization at the beginning will only take a few 
minutes  and save you lots of time down the road. This section also gets you started with 
the construction of your navigation menu (adding and naming pages).

Starting a New Project

When ShutterBug launches, it does not open with the main application window. You must 
name and create a new project first.  If you are already working on a ShutterBug project, 
you can simply open it from the main menu.  

Start a New Project

To launch ShutterBug and start a new project, follow these 4 steps:

1. Double-click the ShutterBug icon to launch ShutterBug.

2. Go to the Main Menu and select File -> New.

3. A Save As window will appear that prompts you to name your ShutterBug file and 
choose the location where you would like it to be saved.  

4. Click Create.  A new ShutterBug project will open in the Content window. 

Open An Existing  Project

To open an existing ShutterBug project or file, follow these 6 steps:

1. Double-click the ShutterBug icon to launch ShutterBug.

2. Go to the Main Menu and select File -> Open.
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3. The finder window will open. Locate and select the desired file on your computer. 

4. Click Open. Your ShutterBug project will open in the Content window. 

5. ShutterBug stores a history of your 9 most recently opened ShutterBug files. To open 
a recent file, go to the Main Menu and select File->Open Recent.

6. A submenu will open showing your most recent ShutterBug files. Select the desired file 
from the list to open it.  

Setting User Preferences

Before you import any photos or start 
building any pages, go to ShutterBug 
Preferences from the Main Menu. The 
preferences window contains a few op-
tions you should set before getting started 
with your pages. The preferences window 
will open with the General tab selected.

General Tab 

The General tab contains the field for entering your registration number, as well as a few 
other handy user preferences.  
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Registration Number

Enter your registration number in the field provided. This will remove the demo water-
mark from your uploaded pictures.  Make sure the message below your entered number 
changes to say "Registration Number is valid."  Do not hit the space bar after entering 
your registration number - this will yield an invalid number.  If you do receive the "invalid" 
message, double-check that you have not entered an extra space at the end of your regis-
tration number.  

Check for updates when product launched

Check this box  to have ShutterBug automatically alert you when an update is available.  

Automatically launch external browser when done uploading

This option is specific to dot Mac accounts only.  If you plan to export your site to a .Mac 
account, checking this  box will make your default browser automatically open at the URL 
for viewing your site.  This option provides an added convenience as the URL's for ex-
porting to and viewing are not the same.  

Put ShutterBug  in Simple Mode 

This feature was designed for those who do not want to modify the themes and templates 
in any way, or for  those who create sites for clients and do not want the client to touch the 
layout and design of the site. Checking this box will automatically make the Layout tab 
and window invisible on the interface, leaving only the content and preview windows 
available for use.  If this is your first time using ShutterBug, leave it unchecked for now.  
When you become more familiar with all the tools  in ShutterBug, then decide whether you 
would like it on or off. 

Photo Albums Tab

The Photo Albums tab contains the options for  image processing on import and upload of 
the photos.

Photos have been edited by external app 

Click this  button to disable ShutterBug's image processing.  This option is useful for  those 
who edit their photos in an external application and want to keep the compression quality 
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at 100% of the original.  Note:  photos at 100% will take longer to upload, as well as to load 
on your web pages when viewing, because they are much larger in size.  

Enable Image Processing  (Batch processing)

If you are working with large photos, and would like them automatically sized down for 
faster upload and faster viewing on the web, click this button to activate ShutterBug image 
processing.  Check the Resize box to have ShutterBug automatically size down your pho-
tos when you import them.  

Use the Width and Height  fields to specify the desired maximum size of pictures uploaded 
to the web. These values are also the values ShutterBug will use to resize on import. 
ShutterBug will automatically resize your photos no larger than the maximum size speci-
fied in the width and height boxes.  This will only apply to any photos that are larger than 
your maximum values; any photos smaller than those values will remain at their original 
size. 

When you are finished setting your user specific options, click the OK button to return to 
the main window.  

17
 




Set Up General Website Properties

Before you begin adding any content, take a moment to create a few properties that per-
tain to your whole website, or in other words, are constant across  every page in your site: 
Masthead title and Footer text.  All text and links entered in the content editor can be eas-
ily changed or deleted in the future, so don't worry if you aren't sure what you want to 
include for these items just yet, you can change them at any time.  

The masthead is the title or name of your website and shows up on every page in your site.  
It is most commonly used at the top of your website, but can be placed anywhere on the 
page. This could be a company name, a personal name such as My Online Gallery, or  your 
domain name such as mydomainname.com, or whatever  you would like to call your  web-
site. The masthead can also include a link such as linking it to the home page or linking to 
another website. Note: The masthead is not the title of your individual web pages.  

The Footer is the text that displays at the bottom of every page in your website and is the 
same for every page.  It most commonly includes copyright information, and sometimes a 
link  to the parent site or another website, but you can include whatever information you 
want to.

The Masthead

To assign a name to your website (the masthead), follow these 4 steps:

1. Click the Content tab to reveal the content window.  

2. The Navigation pane on the left will contain a heading called Website at the very top 
and is  the starting point for your site. Use your mouse to select the Website heading. 

3. The interface on the right half of the Content window will display the areas for setting 
several different properties. For now focus on the Masthead text field at the top of the 
interface.  
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4. Go to the Masthead text field and click inside the field with your  mouse to input the 
masthead name. By default this field will contain the words "My Online Gallery."  

Note:  The fonts and alignment of the masthead text can all be edited later in the Layout 
window.  

Hyperlinking the Masthead

You can include a link  in your  masthead.  This  link will be available and be the same on 
every page.  To insert a link  into your masthead, follow these 4 steps:

1. In the same window as  above, go to the text field just below your masthead text, called 
Clicking Masthead navigates  to:

2. You can link the masthead to another page in your website or link it to an external 
website. Enter the URL of the page or website you want the Masthead to link to. 

3. To link the masthead to a different website, include the http:// prefix like this: 
http://www.somewebsite.com

4. To link the masthead to another page in your ShutterBug website, drop the prefix and 
enter the page name like this: mypagename.html 

The Footer

The Footer text box  is located just below the Masthead text and link fields. To add the 
footer text and edit it, follow these 3 steps:

1. Click in the Footer text field area and enter the text you would like to have in your 
website's footer, such as copyright information or any other information you want to  
include.  

2. To edit the footer text for alignment, click anywhere on the text (you don't have to 
highlight it), and choose from the icons: left, center, or right align.  

3. To bold, italicize or underline some, or all, of the footer text, select and highlight the 
desired text with your mouse. Then choose from the icons to bold, italicize or  under-
line it. Unlike the alignment, you must have the text highlighted in order for the text to 
change.
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Hyperlinking the Footer Text

You can easily include a link in some of your footer text. To add a link to the footer text, 
follow these 5 steps:

1.  In the same window as above, go to the footer text field area. 
2.  Click anywhere on the desired text that you want to link. You do not have to select 
     and highlight the text unless it is more than one word. 
3.  With the text selected, go to the Link text field just below the footer text box and 
     enter the desired link. You can link the footer text to another page in your website 
     or link to an external web site.
4.  To link to an external website, include the http:// prefix and then the domain name 
     like this:  http://www.somewebsite.com. To have this link open in a new browser 
     window, click the checkbox located to the right of the link text field, called New 
    Window. To have it open in the same window, leave the check box blank.
5.  To link to another page in your website, simply click on the blue arrow button to 
     reveal a drop down list of pages in your site. Select the desired page from the list.  
     Your selected footer text will now link to the selected page.  
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Adding, Naming, & Deleting the Pages in Your Navigation

Now that you have set some general preferences and properties for  your project, you are 
ready to start adding the pages for your website. These operations are performed in the 
Content window as well, so make sure you have the the Content tab selected in order to 
follow along in the correct window. 

Everything you do in ShutterBug can be changed and edited, nothing is set in stone. So 
don't worry if you are not 100% decided on the website name or page names, it's easy to 
change them later. You can add two different types of web pages to your site:  Album 
pages and Group pages.   

Album pages contain your photo galleries of thumbnails and Group pages contain multiple 
albums that you want to group into the same category heading such as Vacations or Spe-
cial Occasions. You can also use an Album page or Group page as a text-only page by en-
tering text and not including any pictures.  As you add pages, ShutterBug automatically 
creates the links for your navigation menu. These pages, their order, and their names form 
the base for your navigation menu.  But before going any further, take note of Shutter-
Bug's hiearchy for web pages:
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The above illustration shows the general hiearchy, but there are certainly many variations 
for pages. You don't have to include a Group in order to have an album. You can go 
straight to an album page and skip the group. Additionally, you do not have to add any 
photos to your album pages; you can create text only pages and have these as part of a 
group or on their own, whatever  best suits  your needs. More about content building is 
covered in the next chapter; this chapter focuses on getting the first necessary building 
blocks into place before inserting any other content.  Adding the pages and naming them is 
the framework for your navigation. 
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Adding an Album Page

An album page is the lower level building block  for  your website that can contain as much 
text content and as many photos as you want. When you open a new project, by default 
the navigation pane is set to the Website heading. Also by default, an album page will al-
ready be added for you to help 
get you started.   

To add an album page to your 
website, follow these 4 easy 
steps: 

1. Select the Website heading. 

2. Click on the Add Album 
icon to add an Album page. 
Alternatively, from the 
Main Menu, click  on Tools-
>Add New Album. 

3. A new album page will be 
added to your list with a 
default name of Page 2 (Page 1 was already added for you when you opened the pro-
ject). 

4. You can also add album pages when you have other album pages selected. But note, 
they will be added to your navigation list as separate items; you cannot add an album 
to an album, or in other words, you cannot stick an album page inside of another al-
bum page. 

Adding a Group Page

A group page is the higher level building 
block that can contain several album pages 
and everything in those pages. You can 
include as much text content and as many 
album pages in one group as you want. 
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To add a group page to your website, follow these 4 easy steps: 

1. Select the Website heading. 

2. Click on the Add Group icon to add a Group page. Alternatively, from the Main 
Menu, click on Tools->Add New Group. 

3. A new group page will be added to your list.

4. You can also add group pages  when you have other group or album pages selected. 
But note, they will be added to your navigation list as separate items;  you cannot have 
a group within a group, nor can you insert a group into an album. However, you can 
put albums into groups as discussed next.

Adding Album Pages to Groups

You can easily add as many album pages to group pages as you want. Simply follow these 
4 steps:

1. Select the desired Group page in the navigation list, in which you want to add an  al-
bum page. 

2. Click on the Add Album icon. The album page will be added to the selected group 
page. 

3. Continue clicking the Add Album icon until you are finished adding pages to the 
group. 

4. To add album pages to another group, repeat steps 1- 3. 
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Naming your Web Pages

Each time you add an album or group, ShutterBug will assign a default name to each one 
in the order in which they were added: Page 1, Page 2, Group 3, Group 4, Page 5 and so 
on. These names are the names or words that will show up in your navigation menu, and 
are easy to edit and change. To name your web pages, follow these 5 steps:

1. Select any page in your navigation list.

2. Double-click on the default text area to highlight the text field.

3. Type in the name you would like to have for that particular page.  

4. The albums and groups in the navigation pane are automatically linked to their  corre-
sponding pages and form the navigation menu for  your website. 

5. To edit the name for any page, simply double-click on the page name text field and 
enter the new name.

Reminder: If your page names span further than the navigation pane window, you can 
adjust the width of the navigation pane using your mouse and moving it left or right to 
decrease or increase the viewable area. This  will enable you to see the entire name for each 
page.   
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Deleting Web Pages

ShutterBug's Trash Can holds onto the deleted items so that you may recover them in case 
you change your mind or delete an item by accident. The Content window is  the only place 
where you can delete content (and recover it). 

1. To delete a page from your navigation list, select the desired page in the navigation 
pane.

2. Use the delete key on your keyboard to send it to the trash, or alternatively drag the 
page to the Trash Can at the bottom of the list. The page plus everything contained 
within it will be deleted from your website and moved into the trash can.

3. To view the deleted content, select the Trash located at the bottom of your navigation 
list.  A window on the right side of the interface will show you the list of  items that 
have been deleted.  

4. To recover  an item from the trash, simply select it with your mouse and drag and drop 
it back to the desired location in your navigation list.

5. To permanently delete the contents of the trash can, select Trash from the navigation 
list, and simply hit the Empty Trash button. All items in the trash will be permanently 
deleted from your website. You cannot recover them after emptying the trash. 
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Arranging Pages & Organizing Site Files

In the Content window, ShutterBug lets  you arrange and reorder the pages in your navi-
gation list by simple drag and drop functionality.  Additionally the handy Navigation Op-
tions make it easy to organize, name, and save your site files, as well as being able to hide 
pages from your navigation menu. It's worth the small effort that it takes  to organize the 
pages and files in your site.  It only gets quicker and quicker in the future when you need 
to do some housecleaning with your site.  

Before going on, view the following diagram to make sure you understand the distinction 
between the Navigation List and Navigation Options. 
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Arranging Web Pages in Your Navigation List

You can move all of your pages up and down in the navigation list, dragging and dropping 
them wherever you want. To rearrange the order of your pages, or move a page to a new 
position, in the navigation list, follow these easy steps:

1. Select the desired group or album page with your mouse and drag it to its  new desti-
nation in the navigation list.

2. To move an album into a group page, select it with your mouse and drag and drop it 
on top of the desired group page. The group's disclosure triangle will turn blue and 
open up. Your album will be dropped to the first position in the group.

3. To move an album into a specific position in the group's list,  click  on the group's dis-
closure triangle to reveal the albums in that group.  Then select the album you would 
like to add, and drag and drop it into the desired position in the list of albums. A black 
guideline will appear to show you where your album will be dropped. You can move 
albums up and down within the group, dropping them wherever you  desire. 

4. To remove an album from a group, select the desired album and drag and drop it 

Organize Your Site Files with the Navigation Options

Ever seen a URL in an address bar that goes something like this:  

http://www.shutterbugland.com/vacations/page1.html? The creator of the website has not 
named or defined the files in his/her website, and hence the reason it gets uploaded at the 
program's  default name for the particular  file. What about wanting to keep certain pages in 
your website but not wanting them to appear  in your main navigation menu?  

The navigation options help you complete both of these tasks, plus a few more organiza-
tional gems. These options keep track of page name changes and are all located under an 
area in the Content window called Navigation Options.  Each time you change or add a 
page name in the Navigation List, ShutterBug will automatically apply the changes to the 
files in your Navigation Options  list, as  well as in the drop down list for  the Link box.  
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Select the Website heading in the navigation list to reveal the Navigation Options pane. 
The navigation options pane will appear  at the right lower half of the main window. There 
are four options: Page, Show, Save As, External Link. The first three are editable and the 
last one is  automatically defined by the Save As entry. Each column in the Navigation Op-
tions can be adjusted for width. Use your mouse to increase or decrease the width of a col-
umn for more or  less  viewing space. Follow the steps below to set the navigation options.

Page Option:

The Page option keeps track of the page order  and page names that are in your navigation 
list. As you can see, they hold the same names and order that you assigned in your naviga-
tion list when you were adding and naming pages. As you change the names  of your pages, 
they will also change automatically in the navigation options  list. Alternatively, you can 
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change the name of a page in the navigation options list. To change a page name in the 
Navigation Options list, follow these steps:

1. Double-click on the page name to activate the text field.  

2. Enter the new text and hit the Return or Enter key on your keyboard. The name will 
automatically change in your navigation list.  

3. To change another page name, enter the new text, and hit Enter.  Each time you hit 
Enter, your cursor will go to the next page in the list automatically highlighting the 
text field so that you don't have to use your mouse to highlight it. Continue down the 
list, inputting the text and hitting Enter, until you are done.  

Show Option:

The second option, called Show, contains checkboxes  for each one of your pages. The 
Show option lets you turn pages on and off in the navigation menu. An exception exists 
with Album pages contained in a Group: pages inside of a group will never show up in the 
main navigation, even if you have specified them to Show. ShutterBug's navigation was 
intentionally designed to not show these pages  in order to implement a second tier naviga-
tion feature which we will discuss later in Chapter 6. To assign the Show settings to your 
pages, follow these steps:
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1. Check the checkbox  to make the corresponding page show up in your navigation 
menu.

2. Leave the check  box  blank to keep a page from showing up in your navigation.

3. Uncheck the check box  to remove a page from the navigation menu.

Note: These actions do not remove any of the pages from your website. You have to delete 
pages to remove them from your  site.  

Save As Option:

The third option, called Save As lists the file names associated with each one of your  pages. 
The file name is the HTML page name that ShutterBug uses  to link  pages together. The 
name assigned is the file name that gets saved and uploaded with your project. ShutterBug 
does not automatically change this name, but rather keeps the default of the page names 
(i.e.page1.html). It's  good practice to give these site files a specific name in order to keep 
things tidy as well as to be consistent with the page name-file relationship. If you ever have 
to examine the package contents of your project or the exported folder, you will be happy 
that you took the time to give these files an identifiable name that you will recognize in the 
relative context of your entire website.  

As an example, let's say I call my first page in the navigation list Welcome.  The file name 
for that page will be listed as page1.html in the navigation options.  This will show up in 
the browser's URL address bar as:  www.xtralean.com/page1.html.  To change this and 
assign file names, follow these steps:

1. To change the filename from the default name, select it with your mouse and double-
click to activate the text field area.

2. Enter the new file name text.  You don't have to enter the dot html extension - Shut-
terBug will automatically add the extension for you.  

3. Then hit Enter or the Return key on your keyboard to go to the next filename in the 
list.

4. Enter the new file name text. Hit Enter to go to the next item in the list.

5. Continue steps 1 through 4 until you are finished.  
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Note: The Save As option will also prevent you from inadvertently giving files the same 
name and accidentally overwriting files. If you try to assign a filename that is already being 
used by another page, it won't "stick."  

External Link  Option:

You can ignore this option as its  purpose has been replaced by the Save As option. Cur-
rently the External Link option has no meaning in ShutterBug but was originally included 
in preparation for adding external links to the navigation menu.This feature has been re-
considered and will become a Paradise feature. Future builds of ShutterBug will have this 
option removed from the interface. 

Congratulations fellow ShutterBugs!  You have just constructed your very own linked 
navigation menu for your website.  

Save & Close Projects, Quit ShutterBug

Currently, ShutterBug does not have a "Save As" feature for your projects, however this 
feature is planned for the near  future. In the meantime, to save a project with another 
name, you will need to make a copy of it on your computer and give the copy a different 
name.  

1. To save a project, go to File->Save from the Main Menu, or hit Command-S on your 
keyboard.  

2. To close your ShutterBug project, go to File->Close from the Main Menu, or hit 
Command-C on your keyboard, or  click  the Close button at the top left corner of the 
main application window.  

3. If you try to close ShutterBug without saving any of your latest changes, a prompt to 
save menu will open.  

4. To quit ShutterBug, go to ShutterBug->Quit ShutterBug from the main menu or 
hitCommand-Q. 
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Chapter 3

Content View: Building your Content

It's important to realize the separation between your content and your design.  The Con-
tent window facilitates content building and basic editing options for your text and photos. 
 Anything to do with design is not part of the Content window. 

Page Titles & Text Contents

Both the group and album pages have an area to add a page title and a text description for 
each page. The content window lets you focus on your content without having to worry 
about the design. It will help you to get your text and page titles in quickly and easily, so 
that you can maintain a fast work flow, and move smoothly from one page to the next. 

The amount of text that can be entered for your page descriptions  is  unlimited. You will be 
able to layout the text box and/or wrap the text and make other design decisions later on in 
the Layout window. The page titles are unique to each page and can say whatever  you 
want them to say. The titles can be as long as you want them to be. As with your other 
content, design decisions for the page title, such as font and position on the page, are made 
later in the Layout window.  

Click the Content tab to open the content window and get started building the content for 
your site. Note: The page you are reading right now utilizes all of the text editing options 
discussed here. 

Adding Page Titles

1. Select a page from your navigation list.

2. A text field labeled Page Title will appear at the top of the content window and to the 
right of the navigation list. By default,  the page title text field will contain the words 
"Some Photos".

3. Click inside the text field and give the selected page a new title. 
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4. If you don't want to include a title for the page, leave the text field blank, or highlight 
the existing title text and delete it. 

5. Continue down your navigation list, repeating Steps 1-3 to give the rest of your pages 
a unique page title. Tip: You can use the arrow keys on your keyboard to move up and 
down the pages  in the navigation list.

Notes:  

• There are no editing options for the page title in the Content window; all editing options 
for the title are available from the Layout window.  

• The page title cannot include a link. 

Adding Text Content to a Page

1. Select a page from your navigation list.

2. Just below the Page Title text field, is a larger text field area labeled Page Text Con-
tents.  

3. Click inside the Page Text Contents field to begin entering some text. You can input as 
much or as little text into this box as you want. It can be whatever you want it to be, a 
brief description that introduces  the pictures, a description about the context of the 
photos, or  an entire story, timeline, or journal about the pictures.  

4. To not include any text at all, simply leave the text contents box blank.
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5. To have a text-only page, enter the text in the text contents box, but do not include  
any photos for  this page. Remember that you can adjust the sections of the content 
window. So if you are creating a text-only page, it's very handy to expand  the text 
contents window for more area to type in your text.   

Editing the Text Contents

The Content editor lets you do some quick  and basic edits to your text contents for each 
page. These editing options include text alignment, bold, italicize, and/or underline the 
text, and make some of the text be a heading or keep it normal. Also note that the spell 
checker is available. 

1. To align the text, click anywhere in the text box  and click the corresponding icon at 
the top right corner of the text contents box. Choose from one of the left, center, or 
right align icons. You do not have to select and highlight the text for the alignment to  
be applied. 
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2. To make different lines of text align differently, include a carriage return between the  
lines. Then click  anywhere on the separated line of text, and click the desired align-
ment from the icons.

3. To underline, italicize, or bold some text, select and highlight it with your mouse and 
click the corresponding icon located at the top right corner of the text contents box.

4. You can add headings to your text contents as well. Click on the line of text you would 
like to make a heading, and then choose the radio button labeled Heading located at 
the top of the text contents  box.  

5. You can underline, italicize, bold, or align headings the same way you do with normal 
text as outlined in Steps 1-3. 

6. To make this text normal again, click on it with your mouse and select the radio button 
labeled Normal.  

  

Inserting Links into the Text

You can link any of your text to another page in your website or  to an external website, 
and choose to have them open in a new browser  window or the same browser window. 
You can also include email links.

Inserting  an Email Link:

1. To link some text to an email address, select the text with your mouse by clicking any-
where on it. Note: To link  more than one word, you have to select and highlight all of 
the desired text with your mouse. To link just one word, you only need to click any-
where on the word. 

2. With the text still selected, go to the text field labeled Link: located just below the text 
contents box. Enter the email address and be sure to include the mailto: prefix. For 
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example, mailto:myemail@address.com.  Do not include any spaces  between the char-
acters. 

3.  This text will now link to the specified email address, opening the person's  email pro-
gram when they click  on it.  

Linking  Text to Another Page in Your Website:

1. To link  some text to another page in your website, select the text with your mouse by 
clicking on it. Note: To link  more than one word, you have to select and highlight  all 
of the desired text with your mouse. To link  just one word, you only need to click 
anywhere on the word. 

2. With the text still selected, go to the text field labeled Link: located just below the text 
contents box, and click  the blue arrow button to reveal the drop down list of pages  in 
your site.

3. Select the desired page to link to from the list. The text will now link  to the selected 
page when clicked on.  

4. To make this link  open the selected page in a new browser window, click  the checkbox 
labeled New Window, located at the right side of the Link  box field. To set it back  to 
open in the same browser window, click the New Window checkbox  to uncheck it. 
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Linking  Text to an External Website: 

1. To link some text to an external web page or another website, click  on the text you 
would like to link. Note: To link more than one word, you have to select and highlight 
all of the desired text with your mouse. To link just one word, you onlyneed to click 
anywhere on the word. 

2. With the text still selected, go to the Link: text field box  located just below the text 
contents box. Type the URL you would like to link  to and be sure to include the  
http:// prefix.

3. To make the external link open in a new browser window, click  the checkbox  labeled 
New Window, located at the right side of the Link  box field. To set it back to open in 
the same browser  window, click the New Window checkbox to uncheck it.  
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Photos, Captions, & Watermarks

The interface for importing photos is much the same as it is in iPhoto.  When you import 
photos, they will line up horizontally in the album window of the interface.  You can drop 
multiple photos or  a folder of photos  into ShutterBug's  album window.  They can be reor-
dered using your mouse to drag and drop anywhere in the album window.  The import 
feature will also automatically import the original file name as the caption. 

This page discusses your photos in relation to album pages and the corresponding interface 
with the album window.  Photos in relation to the Group page interface is different and is 
discussed on the next page (Photo Albums & Groups). Design aspects such as thumbnail 
sizes, photo frames, drop shadows, caption font colors, etc. are carried out in the Layout 
window, or determined by the theme you choose in the Preview window.  These aspects 
are all covered in later  chapters.  For now, focus on your photos and editing them in the 
photo album window under the Content Tab.  
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Importing Photos

You can import photos from iPhoto or from any other folder on your computer. The im-
port feature uses simple drag and drop functionality. Drop entire folders at a time, a selec-
tion of multiple photos at a time, or a single photo. 

1. Select an album page from your navigation list. The album window will appear at the 
middle section of the main window and to the right of the navigation pane. 

2. Drag and drop individual photos  or a folder of photos into the album window. Your 
photos will also be available under the album page in your navigation list.  

3. ShutterBug will automatically import the filename of the photo as  the caption. 

Note:  Alternatively, you can drag and drop photos  via the navigation pane. Simply drop 
the photos  into the destination page in your navigation list.  As you do this, the photos will 
also appear in the album window. 
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Adding & Editing Captions

1. Below the photo album window, there is  a text box, labeled Caption for Selected 
Photo, for entering the desired caption for each photo. If your photos  already have a 
file name, you will see the name appear  in the caption text field.  

2. Select a photo from the album window. The selected photo will have a blue outline to 
let you know which photo is currently selected.  

3. Enter the caption text for that photo in the caption text box.  You can enter as much 
text as you want, the number of lines  and characters are unlimited. 

4. To align the caption text, click anywhere on the text and select from the left, center, 
and right align icons located at the top of the caption text box. 

5. To underline, italicize, or bold any of the caption text, select and highlight the text with 
your mouse. Click  the appropriate icon located at the top of the caption text box. 
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Notes:

• If you need to edit all the captions for  alignment, underline, italics, and bold, don't 
bother doing it now in the content window.  Wait until you move into the Layout win-
dow. The caption editing tools will allow you to change these settings for all photos in 
one swoop, whereas the content window will only let you do it one photo at a time.  

• If you want to include multiple lines in your captions, but are worried about what it will 
look  like in thumbnail view, don't worry about that now.  Go ahead and add the multiple 
lines of text - the tools in the layout window will allow you to later adjust how many lines 
you want to be displayed with the thumbnails, giving you the option to display the first 
line only, no caption text at all, or to display all of it. Regardless of which option you 
choose, all of your caption text will appear with the slideshow or larger picture view.  

• Alternatively, the theme selected when in the Preview window, will have presets  for the 
captions which you may like and may not want to edit at all.  

Adding Links to the Caption Text and Thumbnails

You can add links  to the caption text or embed the links in the photo, or do both.  The 
links  can be linked to another page in your  website or to an external web page or  web site.  
They can have them open in a new browser window or open them in the same browser 
window. 

Insert a Link into the Caption Text:

1. To insert a link into some text in your caption, click anywhere on the desired text with 
your mouse.  If it is  more than one word that you wish you to link, select and highlight 
the text with your mouse.  

2. Below the caption text box, a drop down menu with a text input field is available for 
your links.  Make sure you have Text Link:  selected from the drop down menu. 

3. To link the caption text to another page in your website, click the blue arrow button to 
reveal the drop down list of your pages. Then select the desired page to link  to from 
the list. 

4. To link the caption text to an external web page, enter the URL to link  to into the text 
input field.  Be sure to include the http:// prefix in the URL.  

5. To make the link open in a new browser window, check off the New Window check-
box. To make it open in the same browser window, leave the checkbox blank. 
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Embed a Link into the Photo:

1. To embed a link  into a photo, click  on the desired photo to select it.  
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2. Below the caption text box, a drop down menu with a text input field is available for 
your links. Click on the spin box control and select Image Link: from the drop down 
menu.

3. To link  the photo to another page in your website, click the blue arrow button to re-
veal the drop down list of your pages. Then select the desired page to link  to from  the 
list. 

4. To link the photo to an external web page, enter the URL to link to into the text input 
field. Be sure to include the http:// prefix  in the URL.  

5. To make the link open in a new browser window, check off the New Window check-
box. To make it open in the same browser window, leave the checkbox blank. 

Adding & Editing Watermarks

Watermarks  get applied to either all photos in an album or all photos in your entire web-
site, but cannot be applied to individual photos. The watermark feature is available from 
Tools on the Main Menu (former versions included the watermark feature on the main 
application window).

1. From the Navigation list, select the album that contains  the photos you would like to 
watermark.  
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2. Go to Tools-->Add/Remove Watermarks from the main menu. The watermark menu 
will slide out from the top of the main application window.

3. Enter the watermark text into the text input field and select the position for the wa-
termark  from the drop down list at the right.  

4. Select the desired option for applying the watermark  to the pictures:  apply to pictures 
in the current album only, or apply to all pictures in your website.  

5. Click the Apply button. The watermark  will be applied to your pictures. Note: the 
watermarks are only visible on the big picture view; they do not appear in thumbnail 
view and can only be seen in Preview mode. 

6. To apply watermarks to photos in other albums, repeat Steps  1-5. 

7. To edit the watermark, repeat Steps 1-5, inputting the new text and selecting the new 
position from the options in the watermark  menu.  Hit the Apply button to apply the 
changes to your photos. 

Removing  Watermarks

1. From the navigation list, select the album that contains the watermarks you would like 
to remove.

2. Go to Tools-->Add/Remove Watermarks from the main menu. The watermark menu 
will slide out from the top of the main application window.

3. To remove the watermark  from your pictures, either select No Watermark from the 
drop down list, or highlight and delete all of the text in the text field to make it blank.

4. Make sure the desired option is  selected: if you want to remove the watermarks from 
the current album only, choose the first option; if you want to remove the watermarks 
from all of the pictures in your website, choose the second option.

5. Hit Apply. The watermarks will be removed. 

Notes:  

• New pictures  that are imported after adding watermarks, will not take on the water-
mark. You will have to follow the same steps above to give newly imported pictures a 
watermark.

45
 




• ShutterBug will rebuild your photos after  you have specified to add or remove water-
marks. If you're working with a large number of photos on each page, it make take a bit 
of extra time to rebuild the photos if you have chosen to apply the watermark to all al-
bums in the site. 

Photo Albums & Groups

Now that you have added album and group pages, and built some text and photo content, 
you have probably noticed that the interface for albums and group pages  are slightly dif-
ferent. The major difference is  the bottom of the user  interface: albums contain an area to 
add and edit captions, while groups replaces this area with an option labeled Select Photo 
in Album for thumbnail with the selected album. This  option lets you choose the thumbnail 
from each album in that group, that you want displayed on the group page. We've already 
covered the options available for Album pages on the previous page.  Therefore this page 
will focus primarily on using Groups.  
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Using  Groups

Groups act as springboard pages to navigate to separate albums that share the same cate-
gory.  An example of a group could be "Christmas" which is then divided into years by 
each album: 2000, 2002, 2003, 2004, 2005.  Each album contains  the Christmas photos for 
the corresponding year. Another example could be a group called "Trips" or  "Vacations" 
which is divided into sub-groups (albums) by destination:  Greece, Tokyo, Alaska, France. 

The editing options for Groups regarding page titles, text contents, and adding links  are 
the same as they are for album pages. The options change where your photos are con-
cerned.  Additionally, the sections of the application window cannot be adjusted for  groups 
(with the exception of the navigation pane).  

The photos that display on your group pages, are the first photo from each photo album 
contained within that group.  The name of the album page automatically becomes the cap-
tion for  the thumbnail displayed on the group page. The thumbnails  will automatically link 
to the corresponding album when someone clicks on them. There are no editing options for 
the captions on a group page under  the Content window (you can shut these captions off 
and perform other edits when in Layout mode, discussed later). 

The only editing option available for  the photos on a Group page is selecting which photo 
you would like to use to represent the corresponding photo album. To make this selection, 
follow these steps: 

Select a group page from your navigation list to reveal the contents of the group.  By de-
fault, the first photo from each album contained within the group, will be the one that is 
displayed on the group page.  

1. Click on the first thumbnail in your group (it will be highlighted with a blue outline) to 
select it.

2. To choose the photo to display on the group page, click on the Select Photo in Album 
for Thumbnail button, located at the bottom of the window. 

3. A window will slide out from the top of the main application window, displaying all  
the photos in that particular album.

4. Use your mouse to select the photo you would like to use on your group page to repre-
sent the album.

5. Hit the Apply button.  The new selection will now appear on the group page, keeping 
the same album page name for the caption.  

6. Repeat steps 1-6 to choose the photo for the rest of the albums in the group.
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Editing Your Photos

Our popular image editing tool, ImageWell, is built-in to ShutterBug to help you make 
quick  and easy edits to your  photos, so that you don't have to open up multiple applica-
tions. The ImageWell editor can be accessed from all three windows at any time (Content, 
Preview, Layout). While in content mode, for both album and group pages, simply double-
click on the photo to open it in the ImageWell edit window. Alternatively, select the photo 
from the navigation list. While in preview or  layout mode, Control-Click  the photo to open 
it in the ImageWell edit window.  

The edit window will display the photo at its original size in the top half of the window. It 
will also show the photo's dimensions and allow you to display the photo at different sizes 
on the canvas for easier editing. The bottom half of the window contains the Tools  pane. 
The tools pane provides the tools needed to crop, rotate, add draw objects, labels, zoom 
and reposition the thumbnail for the thumbnail view. Recall that compression options for 
the pictures are available from the Preferences pane, and sizing for the large picture dis-
play and thumbnail display are available in the layout window (discussed later in Chapter 
6).  
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We used the ImageWell editor to add the labels to all of the screen shots in this  manual. If 
you are already familiar  with ImageWell you may want to skip the following section and 
move on to Chapter 4. Preview & Test Your Site. 

Using  the Photo Editing  Tools

NOTE:  If you add draw objects to your photos, you must check the Show Draw Objects 
checkbox  to make them appear on your thumbnails.  With this box  checked, you will also 
be able to see the objects in the thumbnail viewer window of the ImageWell editor. You 
can uncheck this  box at any time to make them invisible on your thumbnails, but they will 
still show up on the larger view of the photo. To remove the draw objects completely, sim-
ply select them with your mouse and hit the Delete key on your keyboard.  

Cropping  a Photo: Indestructible Crop

Indestructible crop means you can crop a photo without making it a permanent crop. You 
can go back at any time and adjust the crop box  to make the cropped area bigger or 
smaller, or delete the crop box to return to your original uncropped picture.  
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To Crop a Photo:

1. Select the crop button.

2. Click on the picture in the viewer window and drag your mouse over the area you wish 
to crop. A crop area rectangle with 8 grab handles  will appear. 

3. Click and drag the grab handles to adjust the rectangle or click  anywhere inside the 
rectangle and drag it with your mouse to move it. 

4. Click the Select button to crop the photo.  Hit the delete key on your keyboard to can-
cel the crop action. 

To Change or Remove the Cropped Area:

1. Double-click on the thumbnail to open the photo in the ImageWell edit window.

2. Click the Crop button to display the crop area rectangle.  Your  entire original image 
will appear with the cropped off portions faded out. 

3. Click and drag the grab handles to adjust the cropped area, or hit the delete key on 
your keyboard to remove the crop completely. 

4. Your original picture will then appear, without anything cropped off. 

Rotating  a Photo

1. To rotate the photo 90 degrees counter-clockwise, click  the the button with the arrow 
curving to the left. To rotate it counter-clockwise another 90 degrees, simply click  the 
button a second time.

2. To rotate the photo 90 degrees clockwise, click  the button with the arrow curving to 
the right. To rotate it clockwise another 90 degrees, simply click the button a  second 
time.
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Adding Text, Text Boxes, and Text Labels to Your Photos

1. To add straight text, without a bounding text box around it, click the Text button.  

2. Click on the photo to activate the text tool.

3. Double-click the default text to select it and enter your own text. A bounding box  with 
grab handles will appear to serve as a guide, but is not visible after  you click  off of it. 

4. To add text with a bounding box, select the Text Box  button.

5. Click on the photo to activate the text box. 

6. Double-click the default text inside the box to select it and enter your own text. The 
bounding box  will remain visible with your text on top of the photo.  

7. To add a label to your photo, select the Label button.

8. Click on the photo to activate the label box.

9. Double-click the default text inside the box to select it and enter your own text. Use 
your mouse to grab the yellow handle at the end of the arrow to move and point the 
arrow to the right place on the picture. 
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Adding Thought Clouds and Talking  Balloons to Your Photos

1. To add a thought cloud above someone in the photo, click  the Thought Cloud button.

2. Click on the photo to activate the thought cloud. 

3. Double-click the default text inside the cloud to select it and enter your own text.

4. Use your mouse to grab the yellow handle at the end of the cloud pointer to move and 
point it to the right place on the photo.

5. To add a talking balloon, click  the Talking Balloon button and repeat Steps 2-4.  

Adding Circles, Squares, and Arrows to Your Photos

1. To add a square to your photo, select the icon containing a square.

2. Click on the photo to activate the square. 

3. To add a circle to your photo, select the icon containing a circle, and repeat Step 2 
above.

4. To add an arrow to your photo, select the Arrow icon.  

5. Click on the photo to activate the arrow tool. Your cursor will become a cross-hatch 
tool. 

6. Click and drag your mouse to draw the arrow.  

Note: The square and circle tools do not contain text or any color fill; they only have out-
line borders. Their intended use is  for  circling areas in a diagram or highlighting specific 
areas. 

Resizing  and Moving  Draw Objects

Draw Objects include all of the above mentioned objects: text, text boxes, labels, thought 
clouds, talking balloons, squares, circles, and arrows. 

1. To resize a draw object, click the Select tool and then click on the object with your 
mouse.

2. Grab handles will appear around the object. Use your mouse to grab and drag the 
handles  in or  out to the desired size.
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3. To reposition an object, select the center of the object with your mouse and move your 
mouse to drag and drop the object to the desired position. You can position objects 
outside of the photo boundaries  as  well.  

4. Arrows are an exception to the above rules: to resize an arrow, select it with your 
mouse.

5. Then select the yellow grab handle at the end that has the pointer/arrow. Use your 
mouse to drag the arrow larger or smaller.

6. To reposition the arrow, select the yellow grab handle at the opposite end (or the tail 
end) and drag your mouse to move it.  

Editing Draw Object Borders and Color Fills

1. To change the color of an object's borders, select the object with your mouse.

2. Then select the color well on the right side, to open the color palette. Select the desired 
color. Use this color well for  circles, squares and arrows also. 

3. To change the color fill of an object, select the color well on the left side, and choose 
the desired color from the palette. 

4. To adjust the size of the border widths of an object, first select the object.

5. Then use the slider bar to increase the border size by moving it to the right, or  to  de-
crease it by moving the slider  bar to the left.  

Editing Fonts in Draw Objects

1. To left, center, or  right align the 
fonts in a draw object, double-
click to select and highlight the 
text with your mouse.

2. Click the desired alignment icon to 
align the font: left, center, or right.

3. To edit the font for  color, size, and 
style, double-click  to select the 
text.

4. Click the Font button (f) to open 
the font menu.  Make the desired 
selections.
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Deleting  Draw Objects

To delete any of the draw objects, simply select the object with your mouse and hit the de-
lete key on your keyboard. The changes are reflected in the thumbnail viewer when you 
click on the photo inside the viewer.

Using  the Thumbnail Zoom Tool

1. To zoom in on a photo, use your mouse to move the slider bar to the right. 

2. To reposition a photo inside of the thumbnail view, or the way it will be displayed in 
the photo album page, grab the thumbnail with your mouse inside the small viewer, 
and drag it to the desired position.

3. Draw objects will automatically be displayed on the large picture. You can choose to 
have them show up on the thumbnails as well, by checking the check box below the 
thumbnail viewer called Show Draw Objects. Leave it unchecked to hide draw objects 
in thumbnail view.
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Chapter 4

Preview & Test Your Site

After  you are finished building content in the Content window, click the Preview tab to 
reveal the Preview window.  The preview window contains a built-in browser for the con-
venience of testing and reviewing your site.  Note:  Earlier versions of ShutterBug con-
tained a built-in Safari browser. The built-in Safari browser has since been replaced by 
XtraLean's own proprietary browser.

Preview facilitates the following operations:

• Select a Theme for the look and feel of your site.

• Select a template for your pages - the same template for all pages or a different template 
for each page, or any other combination you would like for your pages.  

• Test links, including email links and external links.

• Test the navigation and preview your content.

• Preview your slideshow and thumbnail mouse-click  actions.

• Export your website to the web or a folder on your computer (Chapter 5).

Themes & Templates

ShutterBug's Theme Library offers 45 customizable themes to select from (more custom-
izable themes will be available soon for free download), and include 5 templates in each 
theme. But you do not have to stick  with any of these themes, you can create your very 
own design if you like.  The "in's" and "out's" of creating your  own themes and templates, 
and creating your very own design are discussed later in Chapters 6 and 7. This page dis-
cusses how to apply themes to your site and how to apply different templates to individual 
pages from within the Preview window.  
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What is the Difference Between Themes and Templates?

A theme contains the design and color scheme for your  website. A template contains a spe-
cific layout for an individual web page in your site. You can think of themes as the frame-
work for your entire site and templates as the layout of your content for individual pages.  
Themes are applied to the entire website whereas  templates are applied to individual 
pages. 

Themes dictate where the masthead, navigation menu, page title, and footer are positioned 
on every page, as well as the color scheme and other design traits that are common to 
every page in your site.  Templates dictate where the text contents, photo albums, and 
slideshow are positioned within the framework. Templates are handy for publishing a vari-
ety of different pages in your site such as, a welcome page, a group page, a photo album or 
portfolio page, a text page, and contact page.  Alternatively, if you wanted to keep every 
page the same, such as the same group or photo album layout for every page, then you 
would only use one template in your web site. 

Working With Themes

Themes get applied to your entire website and provide the general color scheme, position, 
and layout of the elements  that remain constant on each page (i.e. masthead, footer, navi-
gation, page title).  You cannot apply different themes to different pages, the theme is  ap-
plied across all of your pages. 

Select & Apply a Theme to Your Website:  

1. Click the Preview tab to open the Preview window containing the built-in web 
browser. 

2. To select a theme, click  the Select Theme button. This will open ShutterBug's theme 
library in a window that slides  out from the top of the main application window. 

3. The theme library contains five main categories of built-in themes:  Photo Albums, 
Classic 1.0, Back in Black, Journals, and Geometric.  Each category contains  nine 
different themes. The library will open with the first category, Photo Albums selected.

4. Click on any of the category buttons to view the enclosed themes.  

5. Choose the theme that best suits your taste and type of website - some are designed for 
photo albums, others for text and photo albums, while others are set up for photo 
journals, travel logs, and news stories. 
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6. To apply the desired theme to your website, select the theme thumbnail with your 
mouse and hit the Apply button. The theme will instantly be applied to all pages in 
your website.

7. Click through your navigation menu to review your site with the new theme.  

Where & How to Get More Themes:

• ShutterBugLand.com:  ShutterBugLand is  a website for registered users to browse and 
download more themes.  These themes are all customizable and free.  These themes are 
currently being updated for the template changes in Version 1.1 and should be ready 
very soon.  We will notify you of availability at xtralean.com as well as at the support 
forums.  

•  ShutterBug Theme Exchange:  This is  a user  forum that will be available at the 
XtraLean support forum to facilitate the sharing of user themes and posting website 
links. 
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Working with Templates

Each ShutterBug theme contains 5 different template styles to choose from to quickly 
customize different pages in your site. Templates get applied to specified pages in your site 
without affecting the other pages. They provide the general layout for your text content, 
photo albums, and in some cases, the slideshow. Templates are a faster  alternative for 
customizing pages for people who don't want to alter the design or don't have time to move 
things around in the Layout window. 

Select & Apply Templates to Your Web Pages: 

1. Click the Preview tab to open the Preview win-
dow. 

2. To select a template for a page, first select the 
page you wish to change from the page list drop 
down menu located at the top left corner  of the 
interface. 

3. Click the Select Template >  button to reveal the 
template drawer. The template drawer will slide 
open from the side of the main application win-
dow, displaying a list of template thumbnails. By 
default all of your pages  will have the first tem-
plate applied to them, called "Default Album." 

4. Click one of the template thumbnails  to apply it to 
the current page open in your preview window.  
Don't worry, this action will not change any of 
your content or  affect the other pages in your  site. 
 The template will only be applied to the selected 
page, leaving your other pages untouched. 

5. To view the other templates, simply click on each one to see what it looks like on your 
page until you have found one you are satisfied with. 

6. To give different pages a different template, select the next page from the page list 
drop down menu and choose a template. Repeat these steps for  each page that you 
want to change. 

7. Navigate through your entire site to review the layout for  each page.

8. You can easily change the template on any page at any time by simply selecting a dif-
ferent template from the template drawer.  
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Web Preview Your Site & Test Links

The Preview window is the place to review and check  your site for  any necessary correc-
tions or edits before uploading to the web or  exporting to a folder.  Preview behaves ex-
actly the same as a live browser.  Everything you see in preview mode is what you will get 
on the web, in all modern browsers on multiple platforms.  

NOTE:  Web browsers are free upgrades.  OS 9, OS 10, and Windows all have modern 
browser versions available.  If you discover that one of your visitors  cannot view some of 
your pages properly, the first thing to check  is what browser they are using.  9 times out of 
10 the problem is  stemming from an outdated browser that does  not read modern stan-
dardized HTML and CSS properly.  This is  not just with ShutterBug, if they can't view 
your site properly, chances are they can't view most websites properly. It's quick and free 
to upgrade to the latest browser version available for the particular  OS.  

Previewing & Testing  Your Site:

1. Click the Preview tab to reveal the preview window with the built-in browser.

2. Click through the navigation to check out the roll-overs, click, and current colors of 
the navigation menu, and to view each page in your site. 

3. Click the thumbnails to preview the slideshow, larger picture, or embedded link  action.

4. Click the links in your text description, footer text, and any linked caption text to en-
sure they work, are using the right link, and no typos have been made.  

5. When you are satisfied with your site, hit the Send button to upload it to the web or 
export to a folder on your computer.  See next chapter (Chpt. 5) for instructions on 
uploading and entering web host information. 

Note: Currently the masthead links  are only active once uploaded. Clicking on a masthead 
link  in the preview window will not do anything.  This will be fixed in a future version so 
you can test the masthead link  inside of the preview window. 
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Chapter 5

Exporting Your Site

The best thing about ShutterBug's export feature is that it will remember your web host 
location information so that you don't have to worry about entering it multiple times or 
double-checking it everytime you export.  After the first export to a specific web host loca-
tion, you will never need to access the export window again, unless you need to change the 
web host information or destination that it is  going to. 

ShutterBug will also remember your  changes as you make them. The Send feature makes 
updating your site and making incremental changes a breeze. Simply make the changes 
and hit Send from within the preview window. The changes are automatically calculated 
and exported to your  web space.  

Exporting Your Site

There are two menus to go through when exporting your website: the web host type and 
the password, username, and destination that your site is to be exported to. The export 
feature is  available from the Preview window and from the Main Menu..

Export the Site for the First Time

1. To export your  site, hit the Send button from within the Preview window, or File--
>Export Website from the Main Menu.

2. The export window will slide out from the top of the main application window.

3. From the drop down list, select the destination you want to export to: dot Mac ac-
count, WebDAV, or  to a folder on your computer.

4. Click the radio button labeled Entire Website.  Then click  the Continue button to go to 
the next menu. 

5. The next menu contains the fields for entering your username, password, and directory 
for your web host space. 

60



6. Enter the username and password given to you by your web host provider. Then enter 
the URL where your web space is located.  If you are unsure, contact your ISP to find 
out what your user specific information is. 

7. Hit the Export button to upload your website to your web space. 

Note: After you hit Export, a small ShutterBug progress menu will appear that allows you 
to watch the status of the upload. 

Export Changes to Your Site - Incremental Upload

After  the first export, ShutterBug will save and store your web host information. You'll 
never need to go through the Export menus again unless you have to change your web 
host information and upload to a different location.  Each time you make a change or up-
date your site, all you have to do is hit the Send button from within the Preview window or 
File-->Send Changes from the Main Menu.  ShutterBug automatically calculates your 
changes and uploads only those changes. You can view the changes that are being up-
loaded in the small ShutterBug progress  menu that appears after you hit Send. 

Note: You do not have to upload the changes right away. ShutterBug will always remem-
ber the changes and save them for upload at a later date. 
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Changing Your Web Host Information

To change your web host information, you will need to access the Export menus:

1. Go to File-->Export Website from the Main Menu.

2. From the slide out window, select the new web host location or the host that you need 
to change the information for.  If it is  still a .Mac account, but your user information 
has changed, select .Mac from the list; if you are changing to a non-FTP provider, 
select WebDAV.  

3. Hit the Continue button. The next menu contains the information for the former web 
host you were using.  

4. Enter the new information for your username, password, and directory path for up-
loading your website to.  

5. Hit Export and your site will be uploaded to the new web space location. Your new 
web host information will be saved and you will not have to access the export menus 
again unless you have to change your web host information again.

Note: Currently, this  is the only way to change your  information. Therefore, it's best to 
wait until the next time you need to upload your site, to change the new web host informa-
tion.  If you hit Cancel in the final export window, the changes will not stick and the in-
formation will revert back  to your old web hosting information.

Web Host Locations

ShutterBug supports .Mac accounts and WebDAV hosting.  You can also export the site 
to a folder on your  computer to upload your site using a FTP client. This  page outlines 
some key points to keep in mind when exporting and setting your  user specific information 
for a particular web host account, as well as  how to export to a folder on your computer.  

62



Exporting to a .Mac Account

• Dot Mac accounts use two different URLS: one for uploading to, and a second one for 
viewing.  The URL for uploading to a dot Mac account will look  like this:  
idisk.mac.com/username/Foldername (Pictures, Sites). The URL for viewing a site lo-
cated at a dot Mac account will look  like this: homepage.mac.com/username/foldername

• When entering the URL in the second export menu of ShutterBug, do not include 
"Sites" in the directory - ShutterBug automatically appends this extension for you. If you 
leave the Folder field blank, ShutterBug will upload to your Home directory by default, 
which may interfere with other content you have at your home folder. 

• For convenience, ShutterBug Preferences has an option that you can check off to have 
ShutterBug automatically read and open your default browser at the correct URL for 
viewing after your site is finished exporting.  

Exporting to a WebDAV Host

• WebDAV is short for Web-based Distributed Authoring and Versioning, also referred to 
as World Wide Web Distributed Authoring and Versioning. WebDAV extensions  use 
the http:// prefix  for transferring data from the client to the server.

• The URL for uploading and viewing is the same.  You do not need to enter the http:// 
prefix in the directory box of the export menu, as ShutterBug automatically appends it 
for you. The URL directory of your web host space will be your domain name plus the 
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folder  you are exporting to (if you are using a specific folder off of your main domain 
index  page: xtralean.com/SBManual.  

Exporting to a Folder

To export a web site to a folder  on your computer, follow these steps.  To export only 
changed pages to an existing ShutterBug folder, see the Note below.   

1. Select File-->Export Website from the Main Menu.

2. Select Folder from the drop down list in the export menu. Hit the Continue button.

3. A finder  window will open up prompting you to select the folder and destination on 
your computer to export to.  

4. Select the destination folder or location on your computer, and hit Export. Your site 
and all of the site files will be exported to the specified folder. 

5. To export to a new folder, click the New Folder button while in the finder  window.  
Give the folder a name, specify the location to save to, and hit the Create button. Your 
site and all of the site files will be exported to the newly created folder. 

Note: ShutterBug will also export only changed pages to the folder, overwriting the old 
files with the new.  To export changes to a folder, select File-->Export Website from the 
Main Menu. Select Folder from the drop down list in the export menu.  Click  the Changes 
since last export radio button just below the drop down list. Then hit Continue and follow 
steps  3-5 above.

Exporting to a FTP Host

Currently ShutterBug does not offer FTP as an option to export to from within the appli-
cation. To export to a FTP web host, you must export to a folder on your computer and 
use a FTP client to upload your  web pages.

• To export your ShutterBug website using FTP, repeat Steps 1-5 above to first export to 
a folder on your  computer. 
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• Using a FTP client, log on to  your web space entering your username, password and the 
address to up load to . FTP addresses wi l l look  l ike th i s : 
ftp://yourdomainname.com/foldername.

• Drag and drop your html files into the appropriate area on the FTP client's user inter-
face.  Your files will be uploaded to your web space. 

• Sometimes, but not always, the URL for  viewing is different from the URL for upload-
ing to. This depends on how your ISP manages the web space.  If you are unsure of your 
FTP information, check with your ISP to find out the correct user specific information 
for your account. 

Note:  We cannot support problems that result from using the wrong web host informa-
tion.  We'll try our best to help you figure out the correct URL directory based on the info 
you give us, but we can't guarantee we'll know because the info is user specific to the ac-
count you have with your ISP.  This is private information that only you and your ISP 
have access to. If you are unsure of your  information, ask  your ISP to forward it to you 
and store it in a safe place for future reference.  
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Chapter 6

Layout View: Creating Your Own Design

ShutterBug recognizes that the design of your site is  very subjective and personal prefer-
ences  vary from ShutterBug to ShutterBug. Though we try to provide a variety of themes 
for all tastes, it is  impossible for us to know exactly what each and every ShutterBug wants 
for the look and feel of his/her site. This is where the layout tools come in, providing you 
with the option to create your very own design, personalized and done up the way you 
want it.  

These layout tools  output Cascading Style Sheets (CSS) - one of the most appealing meth-
ods to web developers, but also one of the most frustrating and time consuming to master. 
ShutterBug removes the frustration and masks the complexities  of learning CSS. You 
don't even need to waste time testing your site in multiple external browsers - we already 
did that for you and built it into ShutterBug's output.  

We encourage you to try the layout tools. These tools are among the most powerful fea-
tures  in ShutterBug and offer added benefits over a more expensive, pro-web authoring 
tool.  We hope you discover these tools at your own leisure and see the leverage it gives 
you in creating professional and personalized designs. 

Using the Layout Tools

The Layout window is the place to design anything and everything on your web site, and 
really exercise the true flexibility of ShutterBug. You can create your very own unique 
look  and feel, designing as little or as  much as you want. Anything you create is  equivalent 
to a newly created theme. However, you cannot save your new theme to the library in 
ShutterBug. To save your themes, you must export them to your computer for storage and 
future use. This topic is covered in Chapter 8. Importing & Exporting Themes. 

Get Acquainted with the Interface

The Layout window is divided into three sections: page and template customization at the 
top, web page viewer window in the middle, and the editing tools at the bottom.  This 
chapter focuses on the viewer window and editing tools  (the features at the top of the win-
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dow are discussed later in Chapter 7).  Recall that the layout window is collapsable so you 
can hide the tools along the bottom and gain more work  space in the viewer window. 

The bottom third of the window contains the editing tools for each element in your web-
site. There are eight tabs that contain the tools available for the corresponding element. 
Elements include: Page, Text Contents, Masthead, Footer, Page Title, Navigation, Photo 
Album, and Slideshow. All of these elements can be easily edited for borders, inside mar-
gins, fonts, size, positioning, link  colors, and other traits that are unique to each element. 
Each tab is divided into two subsections: Properties & Borders. The layout window is also 
the place to set the page background for your web pages. The viewer window reflects the 
changes as they are made, as well as offering mouse control to move and resize elements  on 
the fly. 
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How to Select an Element

Before you can view and use the editing tools for an element, you must first select the ele-
ment. The interface offers two different ways  of selecting each element:  

1. Click the tab for the element you want to edit. The element will be selected in the 
viewer window with a grab handle box. The available editing tools will be revealed in 
the pane below the tabs.

2. Alternatively, use your mouse to select the element from within the viewer window. 
The corresponding tab will be selected displaying the editing tools  in the pane below 
the tabs. 

The rest of this chapter covers the available editing tools under each tab, how and what to 
use them for. If you are looking for a specific element to edit, select from the navigation 
menu at the left. Otherwise, go through these pages one at a time, in the same order as the 
navigation menu lists them. 

Page Tab

The Page tab contains the basic properties  for your web pages, most of which are common 
to all of the pages in your website. This is the only tab that is not divided into Properties  & 
Borders sub-sections. Under  the Page tab you can edit only two items: which elements to 
make visible on the page, and the page background. 

Check Item to make visible

You can choose to show or  not show any of the elements on your pages, by simply check-
ing or unchecking the corresponding check boxes - Content (Text Contents), Masthead, 
Photo Album, Page Title, Navigation, and Footer.  As you check  or uncheck  the boxes, 
you can view each element appear and disappear in the viewer window.

Page Background

The page background options let you set the color or use an image for the background for 
your pages. You can keep the page background the way it is in the selected theme, or  you 
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can change it to any color you want, or use an image as the background. If you want to 
keep the current page background the way it is, don't do anything, just leave it. To change 
the background, click  on the spin box  control to reveal the background options:

• To apply a White background, select White.

• To apply a colored background, select Color; then click  on the color  chip to choose a 
color from the color palette.  

• To use an image for the page background, select Image; locate the desired image on your 
computer and drag and drop it into the image well.  Note:  the color that will surround 
the image on the page will be the color selected in the color chip well.  

Repeating  Images:  these options are useful for tiling a graphic across your page to create 
a patterned background.  Repeat Image X means to tile the same image across the X axis 
of your page (horizontally across  the page).  Repeat Image Y means to tile the same image 
across the Y axis  of your page (vertically down the page).  Repeat Image means to tile the 
same image across your  entire page, both verically and horizontally. To repeat an image on 
your page background, located the desired image and drag and drop it into the image well. 
Then select from the repeat image options.

Bitmap Slicer:  this  option is very useful for adding creative backgrounds to your page 
that allow you to easily slice a graphic that you have created in an illustration or graphics 
program.  Illustrators  will find this tool especially helpful. The graphic is dropped into the 
well and then sliced up in order  to display at the top of the page, the bottom, and repeat 
the middle section in the body of the page.  To apply the bitmap slicing, select Bitmap Sli-
cer from the drop down list; then locate the desired graphic on your computer and drag 
and drop it into the image well.
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Text Contents Tab

Click the next tab labeled Text Contents.  The Text Contents tab contains the editing op-
tions for the text you input into the description box in the Content editor. You can edit 
everything from the size and position of the actual box, to the link colors, font styles, and 
borders on the box. Unlike the Page editing options, this tab includes two subsections:  
Properties and Borders.  By default, the pane will open with the Properties options se-
lected.  

Properties Pane

The editing options available from the properties pane, allow you to edit the following at-
tributes for your text content:

Position and Size of the Text Box

You can position and resize the text box by either using the spinbox  controls  or by using 
your mouse in the viewer window.  To move and resize using the spin box controls  simply 
adjust the Top and Left values to move it, and adjust the Width and Height values to resize 
it.  To move the box  using your mouse, select the box  in the viewer window with your 
mouse and drag and drop it to the new position. Select the grab handles with your mouse 
to resize the box  in the viewer window.  

70



Edit the Line Spacing  and the Fonts used in your Text Contents

The Fonts section lets you easily edit the font type, size, and color for both the headings 
and the normal text in your text description.  Simply use the spin box  controls  to choose 
from the drop down list of font types, to increase or  decrease the font size, and click the 
color wells  to change the font color. The line spacing, or line leading, can also be increased 
or  decreased for both the heading text and normal text.  

Edit the Link Colors and Add an Underline to Linked Text

The Links section lets you select the colors for the different states of linked text. You can 
make the linked text be distinct or stand out from the normal text or underline it by 
checking the Underline check box.  The Normal color is the color of the linked text in its 
normal state or its regular state.  The Hover  color is the color that will display on the text 
when someone rolls  their mouse over it.  The Click  color is the color that will display when 
the linked text is clicked with the mouse. Setting the color for  a previously visited link is 
not an option in ShutterBug.

Borders Pane

Click the Borders button, to reveal further properties  for your Text Content. Under the 
Borders pane, you can specify the following settings for the text box:

Add a Border to the Text Contents Box

The Border Style refers to the type of border that frames the text contents box. Select the 
spin box  control to reveal the drop down list of styles. You can choose from Single, Dou-
ble, Dotted, Dashed, Grooved, or Ridged border. In order for  the border to display, make 
sure the Border size settings are not set to '0' (discussed next). 

Select the Border Size and Colors

The Borders settings let you increase or decrease the width of the borders by clicking the 
spin box controls to set the desired width value. Each side of the border, left, right, top, 
and bottom, have to be set individually, and do not have to be the same value. Likewise, 
each border side has a color well. Click  the color  well to change the color  of each border 
side.  As with the size, the colors don't have to be the same color  either. If you do not want 
any borders around your text box, set all the border values to '0'.
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Set the Inside Margins to Help Space the Text Inside the Text Box

The Inside Margins settings allow you to choose the margins for your text description, 
similar to that of a word processor when setting the left, right, top, and bottom margins  of 
your document. The inside margins in ShutterBug serve the same purpose in allowing you 
to space text nicely within a framed text box or to align it with other objects. Click the spin 
box controls on each side to increase or decrease the margins.  You will see the text move 
as you adjust these values.  

Give the Text Box  a Background Color or Background Image

The Background settings  let you change the color or  add an image for the background of 
the text box. This  is independent from the background of the page or any other object on 
the page. The Background settings let you choose from Transparent, Color, Image, or Re-
peating the Image. To keep the background the same color as your  Page background, se-
lect Transparent. To select a different color for the background, select Color from the list, 
and click on the color well to choose the desired color. 

To insert an image into the background, select Image and then drag and drop an image 
into the image well. You can choose to repeat the image horizontally across the X-axis of 
the text box  or  conversely across the Y-axis of the box. Or you can make it repeat across 
the entire area of the box.  If you use an image, be sure to check the color well, to select the 
desired color surrounding the image. Whatever color is set in the color well is the color 
that will display underneath the image.  

Masthead & Page Title Tabs

The Properties for the Masthead and Page Title offer the same options. Therefore we will 
cover them both together in one swoop. Click  the Masthead tab to view the editing op-
tions. Then click  the Page Title tab to see that the options are the same. The editing op-
tions under the Masthead and Page Title tabs  allow you to edit the following properties:
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Position and Size of the Masthead and Page Title Boxes

You can position and resize these boxes by either grabbing them with your mouse in the 
layout viewer window, or by using the spinbox controls to move them over, up, down, or 
to adjust them for width and height.   

Edit the Font used for the Masthead and Page Title

You can edit these fonts for  type, size, color, alignment, as well as underline them, italicize 
or  bold them.  The font section contains a drop down list of available fonts  in ShutterBug. 
Click on the spin box control to reveal the list and select the desired font type to change it. 
Increase or decrease the font size by clicking on the font sizing spin box control. Click  the 
color well to change the font color in the color palette.  Select from the icons to underline, 
italicize, or bold the font, as well as to choose the alignment of the text inside of the mast-
head and page title boxes. The inside margins under the Borders pane can be adjusted to 
move the text in from the edges of the masthead and page title boxes.   

Footer Tab

The Footer tab contains the tools for editing the footer text that you input while in the 
content window.  You can edit the font, edit the links, reposition and resize the footer box 
on the page, as  well as offset the footer  box from the content in the body of your page. The 
editing options under the footer tab allow you to edit the following properties:
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Position and Size of the Footer Box

Clicking the first spin box control (at the top left corner of the tabbed pane) will reveal 
two main options for positioning the footer  box relative to the other content on your page:  
Bottom of Page and Absolute.  

Bottom of Page:  Bottom of Page will automatically move the footer box  to the bottom of 
your page, positioned after your content (text, photo albums, slideshows). The "bottom" of 
the page is determined by where your content ends. This option will make the footer al-
ways automatically position itself beneath your content.  If you add more text or photos 
making the content taller  or the height higher, it will automatically push the footer down to 
adjust for the increase in content, ensuring the footer does not end up overlapping or lying 
on top of your content.  This saves you the step of manually moving the footer box  around 
every time you add more content. 

Absolute: Absolute will release the footer  box  from any automatic positioning. When you 
select absolute, the footer box will jump to the top of the page.  You can grab it with your 
mouse and move it to wherever you want on the page, including overlapping other ele-
ments if you so desire. Using Absolute means that the footer box will not automatically 
adjust when more content is added. You will have to reposition it yourself or select Bottom 
of Page to make it jump back  down to the end of the content.  The primary purpose of the 
Absolute option is to give you an extra box to use on your page for  some other  reason than 
as a footer. For  example, you may want to use it to add to the design of your theme, or to 
add a sub title that is separated from the Masthead and Page Titles and appears on every 
page the way the Masthead does. Or you just may prefer to have copyright information at 
the top of the page.
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Offset Value: The Offset control allows you to increase or decrease the amount of space 
between the footer box and the bottom of the text content and photo album boxes  (Bottom 
of Page setting); or the amount of space the footer is from the very top of the page (Abso-
lute setting). When set to Bottom of Page, Offset refers to the footer box's position relative 
to the end of the content in the body of your page.  It will be offset by the amount of pixels 
you select by increasing or decreasing the offset value, and will always jump down by that 
value as the content grows taller.  When set to Absolute, the Offset value is the number of 
pixels the footer box  is  from the top of the page. It will always stay there regardless  of 
where the other content and elements are, unless you move it yourself or change the offset 
value.  

Other Sizing  & Positioning Controls:  The Left, Width, & Height controls are like all the 
other sizing and positioning controls  for the other elements. They allow you to move and 
resize the footer box  by clicking the spin box  controls to increase or decrease the values. 
Alternatively, you can grab the footer box  in the viewer window and reposition it by drag-
ging and dropping it, and drag the grab handles to resize it. Note: If the Footer is  set to 
Bottom of Page, you will not be able to drag it above the content on your page.

Font & Link Editing  options for the Footer

Like the other elements, the font used for the footer text can be edited for type, size, and 
color, as  well as for the colors of any links included in the footer text.  

Edit the Font: Click the spin box controls  to select the font type from the drop down list 
of available fonts. Increase or decrease the value in the font size controller to change the 
font size, and click  the color well to change the color of the font in your footer.  

Edit the Link  Colors: The Links section lets you select the colors for the different states of 
any linked text in your  footer.  You can make the linked text be distinct or stand out from 
the normal text or underline it by checking the Underline check  box. The Normal color is 
the color of the linked text in its normal state or its  regular state. The Hover color is the 
color that will display on the text when someone rolls their mouse over  it. The Click  color 
is the color  that will display when the linked text is  clicked with the mouse. 

Include the "Created With" Badge on Your Site: If you would like to include the Created 
With ShutterBug badge on your website, simply click the check box beside the label 
"Show Created With" Badge. The badge will be automatically centered on the page below 
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your footer. If the footer is used in the Absolute position, the badge will still be centered at 
the bottom of the page below your other content. The badge does not display in Preview 
mode, but you can see what it looks  like here. If you are a Paradise beta user, the Created 
With Paradise badge is here for  your  viewing convenience as well.   

The Navigation Tab

The navigation tab contains a variety of editing options that let you keep it simple or allow 
you to get a little fancier. There are two elements encompassed in your navigation:  the 
navigation menu, and the menu items contained inside the menu. The menu items are the 
pages in your website, or the names of the pages that you assigned in your navigation list 
while in the Content window.  

Properties Pane

Under the Properties pane of the Navigation tab, you can change and edit the following 
attributes:

Position and Size of the Navigation Menu 

You can either use your mouse to grab the navigation menu in the viewer window or use 
the spin box controls to move the navigation menu to a new position on the page and resize 
the navigation menu box.  You cannot grab the individual menu items for sizing and posi-
tioning as their attributes are relative to the encompassing menu box. The menu items po-
sitioning within the navigation box  is set by other properties covered in the sections that 
follow here. 
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Orientation of the Navigation Menu

The Properties section contains a drop down list that lets  you choose between Horizontal 
and Vertical orientation for your navigation menu. Click the spin box  control and select 
the desired option from the list.  Horizontal will make your menu go across  the page from 
left to right; Vertical will make your menu go down the page from top to bottom.  Differ-
ent pages can have different orientations  by first checking off the Customize this page 
checkbox  and then changing the navigation orientation.  More on customization is  con-
tained in the next chapter -  Customizing Pages.

Edit the Menu Font and Adjust the Spacing  between each Menu Item

The Properties section also contains the options for  editing the font used in the navigation 
menu items. Click the spin box controls  to change the font type and font size (font colors 
are edited in the next section). Click the corresponding icon to italicize or bold the font, or 
to left, center, or  right align the navigation text within the menu. Below these options, is a 
box to adjust the space between each menu item.  Use the spin box control to increase or 
decrease the amount of space between the menu items.  

Menu Item Animation: Create the Rollovers and Other Traits for Your Navigation

The third section on the interface, called Menu Item Animation contains the options for 
adding different behaviors for  your menu items when someone rolls over  or clicks an item. 
Think  of these traits as the different "states" a menu item can be in at a given time or the 
visual queues for your visitors. There are four behaviors you can edit and create:  
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Current:  Current is the current state of the item when someone is currently viewing the 
contents of that particular item.  Or in other words, the current page being viewed is re-
flected or distinguished in the navigation menu by the traits you give it  in order to show 
the viewer what page he/she is currently viewing. Giving the current item a different look 
will make it stand out from the other menu items. 

Normal:  Normal is the regular state of the menu items when no action is being performed 
on them, or rather, while they are idle. The traits you specify for the normal state is  what 
will be reflected on the items when they are not touched or left alone.  

Hover:  Hover, also known as a rollover, is the state the item will be in when someone rolls 
their mouse over the item or hovers above the item before clicking it.  Hover  traits are 
used to make the item pop out from the Normal state, showing the item contains  a link, as 
well as  creating an interesting visual effect 

Click:  Click is the state an item changes to when someone clicks on it with their mouse. 
The click  color  or  behavior is sometimes set to the same as the hover color, sometimes the 
same as the current color, or completely different from the other  three states. These are all 
a matter of personal preference.

Creating  & Editing  the Menu Item Animation States:  All four states, current, normal, 
hover, click, contain the same options:  Background color, text color, and an underline 
option.  The background color  is the color that will show up behind the menu item text.  
The size of the items' background depends on your margin settings  (covered later under 
the "Borders" section).  

• To give a state(s) a colored background, click  the color chip well beside the corre-
sponding state and select the desired color  from the color palette.  

• To apply the color to your menu item, click the checkbox.To remove the color, click  the 
checkbox  again to uncheck  it.  

• To make the font color of the item change with the different states, click  the color wells 
under the Text heading and select the desired color  for each state.  

• To have an item underlined during a different state, click the Underline icon beside the 
corresponding state.  
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Navigation for Pages in Group

 

You can choose to have album pages in a group show up in your navigation menu.  
Showing the pages in a group simply allows users to provide another way for visitors to 
navigate through a Group without having to go back  to the group page each time to select 
the next album.  Doing this means the rest of the items will disappear from the menu when 
someone is visiting the album pages in a group, displaying only the group page plus the 
albums in that group.  When clicking back  to the main group page, the rest of the main 
navigation will show up again, while the group album pages will disappear from the menu. 

To show the album pages of a group in the navigation menu, select Pages in Group under 
the Navigation shows:  heading.  Make sure these pages are already set to "Show" in your 
navigation options of the content editor, otherwise they will not show up.  Alternatively, to 
have the navigation display as normal while visiting album pages in a group, select the Top 
Level Pages option. As an example, this manual uses the Pages in Group option for all 
group pages. You can see in the navigation to the left, that only the pages for this chapter 
are showing.  If you click  on the chapter heading, 6. Create Your Own Design, you will be 
returned back to the main navigation.  

Borders Pane

Click the Borders  button to reveal more editing options for  your navigation menu. The 
borders button contains options for both the Menu Items and the main navigation Menu. 
These options are the same with one exception:  the Menu contains the option to set the 
background color or an image background.  Whereas the Menu Item options do not con-
tain this  feature. The reason for  this is because the background options for the menu items 
are already contained under the Menu Item Animation section of the Properties pane.  
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Menu Item Editing  Options

Click the Menu Item button to reveal the available options. The options here work  the 
same way as the Border  options previously described in the Text Contents section. To re-
cap how to use borders, margins, and backgrounds, please go to the text contents section. 
However, there are some important points  to keep in mind when editing the inside margins 
of the menu items:  

• The menu items are separate elements from the navigation menu. Anything you do to the 
menu items will not be applied to the actual menu. 

• If you chose to use a background color in any of your menu item animation states (while 
under the Properties pane of the navigation tab), that color will fill the area that the in-
side margins are set to. 

• The margin values for the menu items get added to the margin values of the navigation 
menu. If you notice you are getting too much space around the menu items, check the 
margin settings for both the menu item and the menu.  

Navigation Menu Editing  Options:

Click the Menu button to reveal the available options for the borders, margins, and back-
ground of your navigation menu. These options are exactly the same as they are for the 
other elements and work the same way. To review how to use the border  tools, please see 
the Text Contents section.  Again, any margin settings that you specify for  the Menu,  will 
accumulate or be added onto the margin values of the menu items.  

Photo Album Tab

The Photo Album and Slideshow tabs contain a variety of editing options to help you pre-
sent your pictures the way you want.  Everything from custom thumbnail sizes, collages, 
freestyle slideshows to drop shadows, multiple line captions, and much more. The Photo 
Album tab contains the editing options for your  thumbnails and the Slideshow tab (cov-
ered on next page) contains the options for the full size versions of your photos. There are 
a wealth of tools  under the photo album tab, which we'll show you how to use and what to 
use them for. More specifics are covered in the Supplement Guide. 
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Properties Pane

Click the Photo Album tab to reveal the editing options for your thumbnails.  Select the 
Properties button to edit the thumbnail properties of your albums. There are 3 main op-
tions that determine or "set the stage" for the other options  available, depending on how 
you choose to place or position your thumbnails. To stay organized, use these tools from 
left to right as they appear  on the interface. Start with the positioning of your album before 

worrying about the other options. Decide whether you would like to keep the album Ab-
solute, After the Text contents  box, or FreeStyle. The very first drop down menu at the 
top left corner of the photo album pane contains these positioning options.  

Get Acquainted by  Starting with Absolute Positioning

Select Absolute from the drop down menu if it isn't already selected. Absolute lets you 
place your album wherever you would like, including overlapping other elements.  An ab-
solute album position means your album will stay where you place it regardless of the 
placement of other elements. The text will wrap around or adjust to the placement of your 
album, but everything else will remain in its current position on the page.  The options 
available for editing the attributes of an Absolute positioned album are displayed on the 
rest of the pane.  

Using  the Absolute Editing  Options

1. Go to the Position and Size options just below the drop down menu.  Either use the 
spinbox controls to place your album in the desired position on the page or use your 
mouse to grab it in the viewer window and move it to the desired position. Don't spend 
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too much time with the perfect placement right now, as you will probably have to come 
back to this for final tweaking after  setting some of the thumbnail options.  

2. Select the number  of Columns and Rows you would like to display in your album. To 
display all of the photos in your album, set the Rows value to '0' - this will make the 
number of rows unlimited and saves you the trouble of determining how many rows 
you will need to display all of the photos (especially helpful for very large albums). To 
display a limited number of photos in the thumbnail view, select the desired value for 
Rows.  If you only want to show 4 rows of pictures, then use the spin box  button to 
increase or decrease the value to '4'. For example, if your Columns value is set to '3' 
and with Rows at '4', the thumbnail album will display only the first 12 photos  in your 
album.  All of the photos get displayed in the Slideshow.  If your columns value is  set 
to '3' and with Rows at '0' the thumbnail album will automatically display as many 
rows that are needed to display all of your photos. 

3. Go to the next section on the interface, labeled Thumbnail Size & Spacing. Click the 
Change button to reveal the sizing options for your thumbnails. A window will slide 

out from the top of the Layout window. This window allows you to set the size for 
your thumbnails and select from 3 aspect ratio options. In the Width and Height text 
fields, enter the desired size for your  thumbnails (you can specify any size you would 
like). A list of sizes commonly used is  shown at the right side of the window for added 
convenience.  Keep the window open for the next step.

4. With the thumbnail sizing window still open, choose from the three Sizing Options to 
set the aspect ratio for  your thumbnails: 

• Thumbnails are the same size: this option will make all of your thumbnails the size 
specified in the width and height boxes, but will disregard the aspect ratio of each 
picture. 

• Same aspect as  picture: this option will display your thumbnails at their different 
aspect ratios  while remaining within the constraint or size that you have specified for 
the width and height. 
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• Same aspect as  picture, thumbnail is centered: this option will render the same re-
sults  as  the second option, but offers a different display for  how the picture is  cen-
tered inside of a picture frame. If you aren't using a picture frame, you won't be able 
to see the difference between this option and the second one. This option will keep 
the pictures at their same aspect ratios, while centering them inside of the picture 
frames, and keeping the picture frame the same size. It creates a very stylish and ele-
gant visual presentation for your thumbnails. When using frames with the second 
option, the pictures frames take on the same aspect ratio as the pictures, whereas this 
option keeps the frames the same size while keeping the pictures at their  different 
aspects. 

5. Click the OK button to return to the main Layout window.  

6. Below the Change button, are the options to set the spacing between your columns and 
rows of thumbnails.  Simply click on the spin box  controls to increase or decrease this 
space. You can see the changes happening on the canvas  as you adjust the values.

7. The next section of the Properties pane, contains the settings for the Caption text that 
you input while in the Content window.  First select from the drop down menu 
whether to place the captions above or below the thumbnail, or to shut them off and 
make them invisible. The slideshow has separate caption settings, giving the option of 
making them invisible for your thumbnail album view, but making them appear for  the 
slideshow or larger picture view.  

8. The checkbox beneath the caption placement list, pertains  to albums where multi-line 
captions have been used.  Check  this box  to display only the first line of the caption in 
thumbnail view. The entire caption will still show in the slideshow view. To show all of 
the lines in the caption for the thumbnail view, leave this  checkbox  blank.  

9. Next select the font type, size and color for your caption text.  Again, there are sepa-
rate settings for the slideshow caption display, giving you the flexibility to use different 
font settings for the two different views, if you choose to do so.   You can also set the 
alignment and underline, bold, italics for the thumbnail captions independent of the 
slideshow caption settings. These later settings are also available from the Content 
window.  However, the settings you choose in the Layout window will override those 
in the Content window. This serves the purpose of giving you a way to edit  the cap-
tions all at once, instead of one at a time. 

10. Next you can adjust the amount of space between the caption and the thumbnail. Use 
the spin box control to increase or decrease the value to the desired spacing. You can 
also set the value to a negative value in order to make the caption sit inside of a photo 
frame or  on top of the photo. 
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11. The last section on the Properties pane offers a list of alternative actions that can occur 
when someone clicks on your thumbnails. Select the desired option from the list:  

 

• Slideshow (different page): clicking the thumbnail will activate the slideshow on a 
different page than the thumbnail album.

• Slideshow (same page): the slideshow is displayed on the same page as the album 
(and the rest of your elements) and clicking the thumbnail will activate the slideshow 
on the same page. 

• Opens big picture: clicking the thumbnail will not activate a slideshow, but will 
rather open the larger image of the thumbnail in a separate browser window.

• Opens embedded link: clicking the thumbnail will take you to the link which you 
specified while in the content editor.  To choose whether  to have the link open in the 
same browser window or a new browser window, you have to specify this in the 
content editor. 

• Does  nothing: clicking the thumbnail will do absolutely nothing.  

After Text Positioning

After  Text positioning works in the same way that Absolute positioning does, except that it 
will always automatically keep the photo album below the text contents description on 
your page.  Whenever  the text contents becomes larger or smaller in height, or  the text box 
is repositioned, the photo album will automatically adjust downwards or upwards saving 
you the trouble of manually moving it every time you add or delete text, or move the posi-
tion of the text contents box. The same editing options are available for After Text posi-
tioning as for the Absolute positioning options, outlined above. When using After  Text, 
just follow the steps above to edit the attributes of your photo album.  

Note: the Top value for the top position of the photo album is locked into place and basi-
cally doesn't bear any meaning when using After Text positioning. The top of the album 
determines its position based on the bottom value of the text contents box. Even if you try 
to adjust the top of the photo album or try to move it up, it will not go above or  on top of 
the text contents box. In contrast, the Top value for Absolute positioning means the num-
ber of pixels the photo album is from the top of the page.  
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FreeStyle Positioning

FreeStyle positioning offers some added flexibility and additional creative tools for pre-
senting your images. Often in the case where you want to quickly get a photo album to-
gether, you may just stick  with a canned theme and an absolute positioned photo album.  
However, there are many cases  where having total freedom over the individual pictures, 
where they are placed on the page, and how big or small they are, can accentuate any 
presentation of visuals and text, and reinforce the areas you want to emphasize on your 
page.  

The options that differ between FreeStyle and Absolute are the Sizing, Position, and Col-
lage options. Otherwise, the other features are all the same for  any one of the three posi-
tioning options. In other words, the caption features and thumbnail click options remain 
the same for all three positioning options. Therefore this section will cover  how to use the 
options that are unique to FreeStyle thumbnails and will not repeat the other options al-
ready outlined in the above sections.  

Using  the FreeStyle Options

1. Select FreeStyle from the drop down menu to reveal additional options available for 
your thumbnails.   

2. The only section that differs  between Absolute and FreeStyle is the Thumbnail Size 
and Spacing portion of the interface. FreeStyle gives you the ability to have total con-
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trol over each thumbnail as independent items so that you can give each thumbnail a 
different size and place them anywhere you want as separate items. This opens the 
door to create different types of collages as  well. View the pictures below and note the 
differences in thumbnail options:

3. After  selecting FreeStyle, ShutterBug will default to show '0' photos  on your  canvas. 
This in turn, will give the appearance that your photo album has disappeared. Don't 
panic, as they say "things are not always as they appear to be."  Your photos are actu-
ally still there. We will come back  to this in a moment.

4. There are 2 ways to create a collage:  automatic collage settings to choose from, or 
floating photos that can be moved around and sized with your mouse. We'll cover the 
later method first.  

5. Go to the option called Maximum Floating Photos to Display as shown in the picture 
below. Use the spinbox control to increase the value and you will see your pictures 
appear one by one until you have reached the desired number of thumbnails to display 
on your page (this setting does not affect the slideshow, all photos in your album will 
be shown in the slideshow).  

6. Set the value to 5 photos just to try it out. You can set it to anything you want. Go to 
the viewer window and use your mouse to select a photo. Drag it to another position 
on your canvas. Use your mouse to grab the grab handles  and resize it to whatever size 
you would like. The position and size values will change accordingly in the Position 
and Size fields on the interface.  

7. Select the next picture on your canvas using your mouse and repeat Step 6. Do the 
same with the rest of the pictures. Try making them all different sizes and overlapping 
them to create an interesting floating collage.  
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8. Next, try out the Automatic Collage settings. Under FreeStyle Options, click  the Col-
lage Settings button.  A window will slide out from the top of the Layout window. 

9. You can select from 3 main collage styles (A, B, C), and adjust the width and height of 
the collage box, the spacing between the photos, and the number of photos to include 
in the collage. These settings warrant some experimentation to see the different results 
that you can get from using different combinations. Try using different values  for each 
setting to see what it looks like. Including many photos can bear a completely different 
result than using only a few.  The thumbnail in the window lets you preview the layout 
for the different settings.  Keep this  window open for the next step.

10. To make these photos display in the slideshow view, check  off the box  at the bottom of 
the window - Allow photos in collage to show up in Slideshow.  If you leave this box 
unchecked, the thumbnails  contained in the automatic collage will not be clickable or 
show up in your  slideshow. Click the Done button to return to the main window. 

11. Below the Collage Settings button you can add some additional floating thumbnails  to 
the automatic collage display. Increase the value for Maximum Floating Photos to 
Display and then arrange them around your collage. Or leave the value set to '0' to not 
show any floating photos.   

12. Auto crop to fit picture means the picture will be automatically cropped to fit the sur-
rounding box. For example, if you have a portrait picture and have resized the box 
surrounding it during freestyle mode, you can check  off this button to make the picture 
fill the entire area of the bounding box. The same is  true for a landscape picture - if 
you made the surrounding box  tall and thin, you can check  off this option to make the 
picture fill the area of the box, making it appear as a portrait-oriented picture, but los-
ing some of the edges from the thumbnail view.  It is  basically another way to change 
the orientation without losing too much off the sides of the picture, as well as  a way to 
create a variety of interesting squares and rectangles to display your thumbnails with. 
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Borders Pane

The Borders  button contains the same editing features as the other elements, and behaves 
the same way.  It is divided into two sections: 1) Picture Frame and 2) Photo Album.  You 
can apply borders and margins to the thumbnails to achieve a picture frame and matte 
appearance. You can also use a background image for  the frame or inside margins of the 
pictures. The background color  is the color that will appear as your inside margin. This is 
also the place to add a drop shadow to your thumbnails. The drop shadow is not editable. 

The photo album is the surrounding box that encompasses all of your pictures. You can 
add borders, margins, and background images as well. Using a background color will fill 
the entire album background with that color, setting it apart from the background color of 
the page.  

To review Using Borders, Margins and Backgrounds, go back to the Text Contents sec-
tion. 

Slideshow Tab

Click the Slideshow tab to reveal the editing options for your slideshow. At the top left 
corner of the tabbed pane, there are two main options to start from: Standard or FreeStyle. 

The Standard slideshow option keeps the slideshow pictures and labels bound together  in 
a format that is more constrained than FreeStyle. The FreeStyle option separates all the 
items included in your show, and lets you edit and position the labels, captions, and slide-
show as independent items. The purpose of the two different options  is to provide you with 
a quick  way to get a slideshow up, and an alternative way to make the slideshow more 
customized when you want to spend a few more minutes with more detailed edits.  
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Properties Pane

1. Select Standard from the drop down list at the top left corner of the pane, if it isn't 
already selected.  

2. Use the spinbox controls or grab the slideshow bounding box  in the viewer window 
with your mouse to resize it and position it.   

3. To have your slideshow automatically start, check  off the Auto Start check  box under 
Slideshow Options. To include a fade transition 
between each slide check  off the Fade Effect 
check  box. To disclude either one of these 
features from your  slideshow, leave these 
boxes blank. 

4. To create a timed delay between slides, enter 
the number of seconds you would like to show 
each slide for. This is only applicable when the 
Auto Start or Play button is activated. If view-
ers are using the Next and Previous buttons, 
they will naturally be viewing the slides at their own pace.

5. Next you can select which Slideshow Components to display and use for your slide-
show. Each component has its own editing options.

6. Select Caption from the drop down list. To display the caption with your slideshow, 
check  off the Show check box.  Then select the font style, size and color for the caption 
text. If you are using multiple line captions, you can choose to increase the line spac-
ing. Then select the alignment for the caption: 
left, center, or  right align. These settings will 
not affect the caption settings for your photo 
album, the two are independent items.  

7. The next three items in the list are the Slide-
show Controls or Labels  that people will use to 
navigate through your show for viewing. They 
all share the same traits except for the names 
that you assign for each label. The font type, 
size, color, and underline, italicize, and bold 
that you choose for  one control label will also be automatically applied to the other 
control labels.  

8. Select Prev/Next Control from the drop down list. Choose whether to include these 
labels/controls for  your show by checking or unchecking the Show checkbox. Select 
the font type, size, color, and whether you would like the label underlined, italicized, 
and/or bolded.  
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9. Sticking on the Prev/Next control, input the 
text you would like to display for this  control. 
It can be any text you want.  The default for 
most of the themes will have it set to <<Prev 
and Next>> or something very similar to that. 
You can change this text to say anything you 
want, such as Previous Image, Next Image, 
Back, Forward, etc. You can insert special 
characters for arrows, or remove the text arrows 
completely. 

10. Select Play/Stop from the list. Choose to Show or not Show these controls in your 
slideshow and input or change the desired text for these labels. Note: Auto Start does 
not require the Play/Stop controls to be included in the slideshow; AutoStart works on 
its own regardless of whether or not you have 
included the Play/Stop controls. Select Back  to 
Album from the list, and repeat the same steps.

11. The next component in the list is called Back-
ground Box. The background box is the box 
that surrounds the slides.  This box  is used for 
adding an outside frame or background color to 
the slideshow (not the same as adding a frame 
to the slide, but rather synonymous to the 
background and border for  the photo album). You can choose to show or not show 
this box  by checking or unchecking the Show checkbox. We'll get to borders and mar-
gins later. For now, move on to the next component in the list.

12. The last component, called Slideshow Viewer gives you the option to top align your 
pictures so that they all line up at the same top position. This is handy when you have a 
variety of portrait and landscape pictures in the same slideshow. It keeps  them all 
aligned from the top instead of making them display at different top positions. To acti-
vate this  feature, check  the box labeled Top Align Picture. Note: This feature will not 
work if you do not have "Enable Image Processing" turned on in your user prefer-
ences. 

13. The last section on the interface allows you to select which elements  to include on the 
page with your slideshow.    Any elements that you have on the normal view for  each 
page can also be displayed for the slideshow. This allows you to further customize the 
display of your slideshows. Including the elements means you will have to position 
your slideshow around the other  elements accordingly. The slideshow and its labels  are 
the only editable items when in slideshow mode. Check or uncheck  the corresponding 
check  boxes to show or not show the elements you have included in the normal view of 
your web page.
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14. Page Background applies  to an image background, but not the color of the page back-
ground. If you have used an image or  tiled an image in the page background for nor-
mal view, it may clutter, clash or interfere with the colors and options you choose for 
the slideshow. This checkbox gives you the option to shut off such images for the slide-
show view, giving you the best of both worlds, instead of making you choose between 
one or  the other. Check  the box  to make the page background show for your slideshow 
view;  leave the box  blank  to make the page background invisible during slideshow 
view. Note: Making the Page Background invisible will NOT remove or change the 
page background color; this option only applies to an image background.  

Using  the FreeStyle Slideshow Option:

The editing options for FreeStyle are exactly the same as they are for  the Standard Slide-
show. Select FreeStyle from the drop down list located at the top left corner of the pane, to 
reveal the editing options. The difference between FreeStyle and Standard is FreeStyle 
breaks the slideshow elements apart allowing you to position them anywhere you want, 
independent of each other. The Freestyle feature means you can put captions, labels, and 
controls at the side, bottom, top of the picture, and align them however you want with total 
freedom.  Use your mouse to select each component in the viewer window and move them 
around on the canvas. Use the grab handles to resize them each component.  All other 
options are used exactly the same as they are in standard mode.  

Borders Pane

The editing options  under  the Borders  pane are the same for both Standard and FreeStyle 
slideshows. Click  the Borders button to reveal the options available from the borders pane.  

Picture Frame:

To give your slideshow pictures a frame, click the Picture Frame button. The border style, 
size, and color  works exactly the same as it does for all the other elements. Simply select 
the style from the drop down list, choose the colors and use the spin box controls to in-
crease or decrease the size of the border for  each side of the picture. To include an inside 
margin to serve as a matte, increase or decrease the inside margin values, and select the 
background from the Background list.  
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Slideshow Background Box:

If you formerly chose not to show the background box when you were in the Properties 
section, then the options under the Background Box button do not apply. To add a border 
and margin to your slideshow pictures, click  the Background Box  button. The style, color, 
and size, as well as the inside margins work the same way as the other elements. These 
options are applied in addition to the borders and margins that you specified for the image 
itself. 

Click the Preview tab at the top of the main application window to preview your slide-
show. 

This completes the section on editing each element in the Layout window.  If you've just 
created something you like while going through this chapter, and want to save it for future 
use, export the creation to a folder on your computer  for safe storage. It can always be 
built upon further or edited again in the future. To learn how to export the new creation, 
before going any further in this manual, go to Chapter 8. Importing & Exporting Themes.  
If you don't care to save it, move on to the next chapter.  
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Chapter 7

Customizing Pages & Templates

Customization in ShutterBug involves various methods and occurs on 4 different levels. 
The customization features provide a broad flexibility in that you can customize anything 
and everything, from the page elements, to the templates, to entire themes. Every page in 
your website can be customized to be different from one page to the next. This chapter 
divides the how to of customization into 3 sections:  Simple Page Customization, Detailed 
Page Customization, Theme Customization, & Template Customization. The latter 2 go 
hand in hand, and are therefore grouped together  in the same section. 

To recap, Chapter 6 discussed how to use the layout tools to edit certain elements to create 
your own design. We focused on using the tools to apply changes to one page only. This 
section takes you to the next step in showing how you can take your new design (or a 
canned theme) and customize individual pages, while building an entire theme that con-
tains your own customized templates.  

If this  is as clear as  mud, not to worry, we will attempt to take you through the stages of 
customization from simple to more detailed, in that order.  

Simple Page Customization

Simple page customization is  the same thing as adding different templates to different 
pages when in the Preview window.  This  was covered in Chapter 4, Section 4.1 Themes & 
Templates, but we're going to repeat it here for convenience. 

Customizing pages the simple and fast way is available in the Preview window. To get 
started, click  the Preview tab to open the preview window.  Select a theme from the theme 
library, if you haven't already done so.  The theme contains the layout of the elements that 
will be common across all of your pages: masthead, page title, navigation menu, and footer. 
The layout of the content on each page — text description, photo albums, and slideshows 
— is determined by the template that you select for a particular page.  NOTE: Customiz-
ing pages using this method does not allow for  changing style traits  such as font colors, 
link  color, menu animation, custom thumbnail sizes, etc.  
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Customization Using Built-In Templates

Each ShutterBug theme contains 5 different template styles to choose from to quickly 
customize different pages in your site. Templates get applied to specified pages in your site 
without affecting the other pages.  Templates are a faster  alternative to customize pages, 
for people who don't want to alter the design or  don't have time to move things around in 
the Layout window. However, if you like the website with the chosen theme exactly the 
way it is and do not want to customize any of the pages, then do not apply any of the tem-
plates.  

Selecting & Applying Templates to Different Web  Pages: 

1. To select a template for a page, first select the page you wish to change from the page 
list drop down menu. 
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2. Then Click the Select Template >  button to open the template drawer. This drawer 
will slide open from the side of the main application window, displaying a list of tem-
plate thumbnails. 

3. By default all of your  pages will have the first template applied to them, called Default 
Album.

4. Click one of the template thumbnails to apply it to the current page open in your pre-
view window. Don't worry, this action will not change any of your content or  affect 
the other pages in your site. The template will only be applied to the selected page, 
leaving your other pages untouched. 

5. To view the other templates, simply click on each one to see what it looks like on your 
page, until you find the one that is most appropriate for the purpose of that page.  For 
example, you may want your home page to serve as a welcome page to your website, in 
which case you might find the template that contains only one picture (somewhat en-
larged), with some text to be most suitable. 

6. To give different pages a different template, select the next page in the drop down list 
and choose another template from the drawer. Repeat these steps for each page that 
you want to customize.

7. When you are done customizing pages, navigate through your entire site to review the 
layout for each page.

8. You can easily change the template for any page at any time by simply selecting a dif-
ferent template from the template drawer.  If you are satisfied with the changes, you're 
done and are ready to export. 

Detailed Page Customization

Customizing pages by making elements different on different pages is done in the layout 
window.  All of your pages in your website can use the exact same layout, colors, and style. 
Or you can customize specific pages by changing any of the element traits for different 
pages. In any case, these edits  are more detailed as they involve the option to customize the 
elements and template for a specific page, simultaneously. The page customization feature 
in the Layout window will make your pages independent of each other, so changes  are not 
applied across your entire website.  

For example, there may be a template that is close to what you want for a specific page, 
but not exact. So you choose that template as a starting point.  But you want to change 
some of the elements and the way things are laid out in the template, but just for this one 
page. You can edit any of the template's attributes by changing the elements while keeping 
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the edits constrained to the selected page. In this  case, you have customized a page by 
giving it a different template and then making further  edits  to the template attributes.  

Maybe you want to customize each page in your site, but only with a change to one spe-
cific element and how it displays on each page. For  example, you may want the image for 
the masthead's background to change on each page to depict the subject of the page con-
tent. Or perhaps you have a vertical-oriented menu on most of your pages, but want the 
extra space for another page in order to span an album across the page further.  In this 
case, you could change the orientation of the menu to be horizontal for this page only, in 
order  to gain the extra space for your photos.  

Other examples include using different colors on different pages or moving the page title 
into a different position, and just about anything else you can think of can be changed in-
dependent of the other pages in your site. All you have to do is check off the "Customize 
this page" checkbox  and start changing things!

How to Customize Pages By Editing  the Elements

To customize pages by using different styles and elements  on different pages, follow these 
5 steps:

1. Click the Layout tab to reveal the 
tabbed editing pane for the elements in 
your website.

2. Select the page you would like to cus-
tomize from the drop down list at the 
top left corner of the Layout window. 

3. Click the Customize this page check-
box, located just to the right of the page 
drop down list. This will make the page 
and any changes you make independent 
from the other pages  in your site. 
NOTE: IF YOU DO NOT CHECK 
OFF THIS BOX, ALL CHANGES 
WILL BE APPLIED TO ALL 
PAGES IN YOUR WEBSITE (our 
sincere apologies for shouting but we 
don't want you to accidentally apply the 
custom edits to every page).  

96



4. Use the layout tools to edit and change the desired elements on the page.  

5. To customize another page, repeat Steps 2-4. 

Theme & Template Customization

Creating your very own theme is the same thing as creating your own design. When you 
create your own design, you can give it a name and export it as a theme. How to create 
your own design was covered in Chapter  6. You can modify only a few things or redesign 
the entire theme. The WYSWYG layout editor makes it very easy to customize or design 
your own look.  

Additionally, the theme library contains an almost completely blank theme for those who 
want to create their own theme from scratch. This theme is located in the "Photo Albums" 
group of the theme library, and is the last one listed, called "Blank Canvas."  It does not 
come packed with any templates, except for  one default template to help get you started.  

Once you have a theme you like, you may want to create or customize the templates  to suit 
your needs. You can include as few or as many different templates  as you want, or not 
include any at all. The choice is yours, whatever best suits your needs. Keep in mind, the 
template changes you make, are automatically packed in with the current theme you are 
using and will be exported with the theme.  These will be the templates available to you the 
next time you use that theme or import it into a different ShutterBug file.  More specifics 
on creating themes and templates are covered in the Supplementary Guide.
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Template Customization

Customizing templates involves various different options for added flexibility.  At times, it 
may seem a bit confusing, but after you've tried out the steps listed here and have had a 
chance to become acquainted with how it all operates,  customizing templates will seem 
easy. Managing the templates in the template drawer is a different topic and covered on 
the next page. This page covers how to customize existing templates in a theme and how to 
create your own. 

If you are not in the Layout window, click the layout tab to open the layout window. Be-
fore starting, first make sure you are using a theme that contains templates (not the Blank 
Canvas theme). Follow the steps below to begin customizing templates.

To Customize an Existing  Template:

1. Select a page in your site from the drop down list at the top left of the interface. 

2. Click on any template thumbnail in the drawer to try it out on your page. Click  the 
Select Template button to open the template drawer.  

3. Choose a template that is  closest to the template you plan to have when you are done 
editing it.  

4. Before making any edits to the template, decide if you want these changes to take place 
across all pages that use this  template, or only the current page. If you want the 
changed template applied to only the current page, check off the Customize this page 
checkbox  before doing anything.  If you do not check off the customize this page box, 
all pages that use the same template that you are editing will be affected and take on 
the changes.

5. Use the layout tools to edit the elements and layout of the chosen template.

6. These changes will take effect immediately in the template inside of the template 
drawer as well as on all pages that use this template. 

7. To edit more templates, repeat Steps 2-5.

8. When you are finished editing templates, go through the pages in your site and add the 
new templates to the desired pages.  The Customize this page box  does not have to be 
checked off while applying different templates.  As long as pages  use templates for 
customization they will be different according the template you have used on each 
page.  
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To Add a New Template:

1. To create a template from scratch, select a page from the drop down list. 

2. Click on the "Add Template" button. A new template will be added to the end of the 
list in the template drawer.

3. You will notice the newly added template will take on the same name as your web 
page.  The name can be edited as discussed on the next page, Managing Templates.

4. You can now begin editing this new template. 

Handy Tools for Editing Templates

Copy Settings  

This feature is  available from the main menu only and is only available when you are in the 
Layout window.  If you have a customized page, but want some of the elements  to be ex-
actly the same as they are on some of your other pages, Copy Settings  makes it easy and 
quick  to copy whichever elements you want from one template to another. 

While in Layout mode, go to Main Menu-->Tools--> Copy Settings... A window will slide 
out from the top of the main application window.  From the Item list, check off the ele-
ments you would like to copy (copies the element and all of its  traits), and then select the 
template that you are copying the settings to and from.  Click OK to return to the main 
layout window.  The element settings will be applied to your current page and the tem-
plate. 

Convert Custom Page to Template

This feature is  also only available from the main menu and is available only when you are 
on a Customized page in the layout window.  If the Customize this page box  is not checked 
off, the feature is not applicable and therefore "greyed-out" in the main menu.  Convert 
Custom Page to Template is  exactly the same as the Add Template feature.  It is  just an 
alternative way of creating a new template from a page that you have already customized 
without the edits affecting the other pages  in your site. 

With a customized page selected in Layout mode, go to Main Menu-->Tools-->Convert 
Custom Page to Template.  The page and its  settings will be immediately added to your 
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template drawer and the customize this page box  no longer be checked.  This is because 
the page is now using a template instead of custom settings and therefore does  not require 
the customize attribute any longer. 

Quick Tools for Managing  Templates

This page shows you how to choose the thumbnail icon for your templates, how to name 
each one, and how to delete templates from your template drawer.  The ability to rearrange 
the templates in the drawer has not yet been implemented, but is  planned for  a future 
build.

Name & Select the Template Icons

1. Double-click the template from within the template drawer.

2. A small editing window will slide out from the top of the main window.  

3. The first option, called "icon for template" allows you to select an icon for your tem-
plate. Click  on the spin box  control to reveal a drop down list of available icons to 
choose from.  Select the icon that best represents  the layout of your template.  

4. The second option provides a text field for you to input or edit the name of your tem-
plate.  

5. When you are finished, click  the OK button to return to the layout window. 
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Deleting  Templates from the Template Drawer

Your template drawer may contain templates you are not using on any of your pages.  To 
remove these unused templates follow the 2 easy steps  below:

Note:  ShutterBug automatically calculates which templates  are not being used on any of 
your pages, therefore there is  no need to manually check  yourself or have each one se-
lected before performing the operation.  All unused templates  will be removed all at once.

1. From the Main Menu, select Tools-->Remove Unused Templates. A message box will 
pop up verifying that you would like to continue and delete the unused templates.

2.  Click OK to delete all unused templates from your template drawer.  Click  Cancel, to 
cancel the operation.  
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Chapter 8

Import and Export Themes

The Import and Export Theme features allow you to share themes with other ShutterBug 
users. Exporting a theme you have created lets you save and store it for  future use.  Im-
porting a theme lets you use and modify a theme you have downloaded from another 
source external to ShutterBug's built-in library, or  a previously saved theme. You cannot 
add, delete, or  rearrange the themes in the ShutterBug theme library. The import and ex-
port theme features are only available from the Preview window.  

To Import a Theme

1. Select the Preview tab to open the Preview window.

2. Select Tools --> Import Theme from the Main Menu.

3. Locate the desired theme from the finder window. ShutterBug themes have the .sbtm 
file extension.  

4. Hit Open. The imported theme will be applied to your  entire website immediately. 

To Export a Theme

1. Select the Preview tab to open the Preview window.

2. Select Tools --> Export Theme from the Main Menu.

3. An Export window will pop up.  Name the theme and select the location on your com-
puter to export it to.  

4. Hit Export. The exported theme will be saved to the destination folder. 

Tip:
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You can easily organize your ShutterBug themes by keeping them altogether in the same 
folder  and sub-folders.  For example, you can create a folder  called "SBThemes" and im-
port and export to that folder to access  new themes, replace older themes with updated 
ones, and add and delete themes.  This will also be handy for uploading and downloading 
themes from different sources.

Where to Get More Themes

ShutterBug's theme library includes 45 customizable themes that all contain 5 templates 
each.  You can modify these themes, as  well as add, delete, and modify the templates. Ad-
ditional themes will be available soon from the following resources:

• ShutterBugLand.com:  ShutterBugLand is  a website for registered users to browse and 
download more themes.  These themes are all customizable and free.  These themes are 
currently being updated for the template changes in Version 1.1 and should be ready 
very soon.  We will notify you of availability at xtralean.com as well as at the support 
forums.  

 

• ShutterBug Theme Exchange:  this  is a user forum at the XtraLean support forum to 
facilitate the sharing of user themes and posting website links. 
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Chapter 9

Adding Meta Tags & Additional HTML

The advanced editor was added to ShutterBug's content window to accommodate those 
users who have requested a place to add extra meta tags and their  own additional HTML.  
If you don't know what meta tags are, then the advanced edit window is most likely 
something you will never need to access.  

Because ShutterBug is  a WYSIWYG web authoring tool (and not a HTML authoring 
tool), it already outputs the correct HTML for all browsers on cross-platforms.  We 
strongly recommend not adding your own HTML unless you are experienced in HTML 
coding. If any of your HTML is  incorrect, this may result in rendering problems in differ-
ent browsers. We do not support problems encountered from incorrect HTML.  

To access  the advanced editing options, click the Content tab to reveal the content win-
dow.  Select Website from your  navigation list.  Click the Advanced button located at the 
top right corner of the interface.  The right side of the interface will open a pane containing 
the fields to enter META tags and additional HTML. 

Meta Tags:  meta tags allow you to specify a language for your site, as well as description 
and keyword tags for search engines to search on. Note: Most search engines today do not 
use meta tags to determine content or search ranking. Most only search by the actual con-
tent on your  web pages.

Additional HTML:  you can add your own <head> and <body> content.  If you have an 
external style sheet, you can add it into these areas of the HTML output, however we do 
not provide support for this.  
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Appendix A

Where to Find More Information

1. Help Guide Supplement: The supplement guide is an extension of the topics discussed 
in Chapters 6 & 7 of this manual.  It was  created to help you learn how to make your 
own designs and help you get the most out of the design tools in the Layout window.  
It is currently being updated to reflect the added features and changes in the user in-
terface for Version 1.1. 

2. XtraLean Support Forums:  For self-help and the most up to date information, please 
visit the  XtraLean Support Forums at:  xtralean.com/Support. The support forums 
contain an FAQ section(frequently asked questions), a knowledge base, and a discus-
sion board community to help you get the most out of our products.  The latest up-
dates, fixes, and announcements  for future releases are all contained at this board as 
well.

3. ShutterBugLand and Theme Exchange Forum: ShutterBugLand is a website that 
hosts several additional themes for free download, coming soon. Over the next week, 
the theme exchange forum will be added to the XtraLean Support board and will fa-
cilitate theme exchange between ShutterBug users and posting of ShutterBug sites to 
share with others.  

4. ShutterBug Quick Start Guide: currently being updated for Version 1.1.  

5. Download ShutterBug:  For download instructions, please go here.   To purchase a 
registration number to unlock the demo watermark, go here. 

6. Overview of ShutterBug: For an overview and to learn more about ShutterBug's  
features and capabilities, please go here.  

7. Email Us Directly:  If none of these resources  can answer your question(s), please 
email Customer Support for more help.  Email Sales Support for pre-sales questions or 
any problems purchasing ShutterBug from our  online store.  

8. XtraLean Insider:  Join our email newsletter to get information about pre-release 
software, what's new with our latest developments, and early notification on the avail-
ability of current developments. We will not use your email address to spam you, we 
dislike spam as much as you do.  Send an email to XtraLean Info to join the list.
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